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KATA PENGANTAR

syukur penulis panjatkan kehadirat Allah SWT, karena berkat
rahmat dan karunia-NYA penulis dapat menyelesaikan buku
praktikum komputer bagi mahasiswa. Buku ini disusun untuk membantu
mahasiswa dalam menggunakan komputer baik perangkat lunak sistem
maupun aplikasi.

Buku praktikum ini merupakan edisi kelima yang dibuat penulis untuk
praktikum mahasiswa, berbeda dengan edisi sebelumnya buku praktikum
kali ini membahas masalah pengenalan sistem Windows, Microsoft
Word, Microsoft Excel, Microsoft Power Point, Photoshop, SPSS dan
Mirosoft Visio yang disesuaikan dengan kebutuhan mahasiswa.

Pada kesempatan ini penulis mengucapkan terima kasih kepada Bapak
Drs. M. Erwin Siregar, MBA, yang selalu mengingatkan kepada setiap
orang, khususnya penulis untuk terus berinovasi terhadap hal-hal yang
baru dan bermanfaat. Ucapan terima kasih ini juga saya sampaikan
kepada seluruh staf Pusat Komputer dan Bahasa Universitas Medan
Area, yang telah banyak membantu penulis dalam menyusun buku ini.

Penulis menyadari bahwa buku ini masih belum sempurna, seperti
pribahasa mengatakan ~tak ada gading yang tak retak . Oleh karena itu
saran dan kritik sangat diharapkan untuk kesempurnaan buku praktikum
ini yang tujuannya untuk meningkatkan kemampuan mahasiswa dalam
menggunakan komputer.

Medan, Oktober 2015
Penulis,

Sutrisno, S.T., M.T.
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MICROSOFT
WINDOWS 7

A . Windows 7 merupakan sistem operasi terbaru yang

oleh perusahaan Mircosoft. Fitur-fitur yang dimiliki

Windows 7 cukup komplek dan beragam, mulai dari fitur-fitur baru hingga
fitur lama yang telah ditingkatkan kemampuannya.

A. MENGENAL WINDOWS 7

7 merupakan sistem operasi yang memiliki banyak

sekali fitur dan beberapa tampilan baru.
Berikut adalah Fitur-fitur terbaru Windows 7 yang tidak ada pada system

8.

9.

operasi windows sebelumnya :
1. Jump List, untuk menampilkan
dan membuka file program hanya
dengan klik kanan pada tombol
program yang dinginkan.
2. Aero Peek, untuk melihat jendela-
jendela program yang terbuka di
Desktop dengan tampilan samar-
samar.
Aero Snap, untuk memperbesar tampilan jendela program secara
cepat dan praktis.

. Aero Shake, untuk menimalkan ukuran semua jendela yang aktif

pada layar secara cepat.

. Aero Flip 3-D, untuk menampilkan semua jendela program secara

tumpang tindih.

. Internet Explorer 8, merupakan browser internet baru yang

memberikan akses lebih cepat dengan tingkat keamanan yang cukup
baik dibanding versi sebelumnya.

Gadgets, yaitu pengganti dari Sidebar yang ada di versi Windows
sebelumnya. Gadget ini merupakan aplikasi untuk menampilkan
informasi seperti : Jam, tanggal, Memory, Kecepatan dan lain-lain
pada desktop.

Desktop Slide Show, yaitu untuk mengubah tampilan desktop
dengan beberapa gambar secara berubah-ubah.

Parental Control, untuk membatasi hak akses pengguna atas
program-program apa saja yang boleh dibuka.

10.Math Input Panel, yaitu untuk membuat dan menulis rumus-rumus

matematika.
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B. MENJALANKAN PROGRAM

L3 Windows Media Player
£ Window, Update
- %P8 Viewsr
B Acerroin
& Adobe
& Canon PING series
i Canon PT0N seres
& Gomes
&5 Maisenange
Microse ke
# Wl Office Aecers 2007
£ Microsoft Office Exced 2007
BB winiawt Oten Geame 2007
i Micresoh Office frfoPath M7
2 Miccosoft Office BaelNote 2067
Micrascft Office Cutiook 2007
5t Mormeal Office Pawarbeint 2407

2. Klik tombol drop View by

Cara untuk menjalankan prorgam adalah :
1. Klik tombol Start  All Programs

2. Misalnya menjalankan program Word,
maka pilih folder Microsoft Office lalu pilih
Microsoft Office Word.

C. MENGGANTI TEMA (THEMES)

Tema (Themes) adalah paket fitur
untuk mengubah tampilan desktop secara
bersamaan yang meliputi : Background
desktop, warna jendela, aktifitas suara
Windows, serta screen saver. Adapun
langkah-langkahnya adalah:

1. Klik tombol Start Control Panel.
Small icons.

3. Klik icon Personalization untuk menampilkan jendela

Personalization

Memilih Control Panel

B botermer ptiors [-Yeree)
10 o St S i

6 Fram and Mosen
B Programs and Femions
B Ragion wsi e
§ Soent

Tampilan Jendela Control Panel
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Change the visuals and sournds on your computer
Change dasktap igons
Chaose rrimave painters
Chsnge your seceunt pictiin

2P
Taskirar anf Szt Menu
Eaze of Acsess Centar

Soupds
Windees Befault

Tampilan Jendela Personalization
Background desktop juga dapat dirubah dengan gambar/foto yang lain
sesuai dengan kebutuhan. Misalnya mengubahnya menjadi foto pribadi
yang sudah tersedia atapun tersimpan di komputer.

Adapun langkah-langkahnya sebagai berikut :

1. Klik tombol Start Control Panel Personalization Desktop
Background Browse (Tentukan Folder yang berisikan
Foto/Gambar)

2. Lalu dilanjutkan dengan memilih Foto/Gambar yang diinginkan.

UNIVERSITASMEDAN AREA
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D. MENAMPILKAN GADGETS KE DESKTOP

Fitur Gadgets adalah fitur
yang baru pada Windows 7, adapun

untuk  memanfaatkannya

sebagai berikut :

adalah

1. Klik kanan pada mouse lalu pilih

Gadgets.

2. Dilanjutkan dengan double Kklik

pada aplikasi yang

tampilkan.

E. PENGATURAN MOUSE

ingin  di

Mouse merupakan peripheral yang berfungsi sebagai piranti
masukan dimana perannya sangat dominan dalam penggunaan
komputer yang berbasis GUI (Grafic User Interface). Pengaturan mouse
dapat dilakukan seperti pengalihan fungsi tombol mouse, pengaturan
mouse pointer, serta style yang lainnya.

Adapun langkah-langkah pengaturan tersebut yaitu klik Start — Control

3P Mouse Properties oy,

Buien configuraion
2 Swach warry and ss-mdery bestons

Salect thig chrmcic b to ke the bufton anhe
gl the aoe vois use for prmery funclicm such
‘28 sekecing arxi 2005

Doclecick spoed

Double cBck the faider ko test your eeting. ¥ the.
Toider does ot 8pen or close, try using a slower
aeding

Speed: Sow Fast

3 Tum on Chkiock Searg

Enbien youts it o o bl o o o
wton To set. befly press the mouse bxtion Ta reieass click the.
mouse Bulton 33N,

Panel - Pilih Mouse, sehingga tampil
gambar berikut:

Jika anda memberi tanda chek pada
Switch primary and secondary buttons,
maka fungsi tombol akan pindah ke posisi
kanan mouse sebagai fungsi yang utama
seperti memilih objek dan melakukan blok
(drag).

Pengaturan Double-klik speed,
berpengaruh pada kecepatan double klik
pada mouse. Posisi slow membuat fungsi
double klik mouse menjadi lambat, dan

fast membuat fungsi double klik mouse menjadi sangat cepat.

KlikLock, pemberian tanda chek pada Turn on KlikLock memungkinkan
anda untuk melakukan klik kembali pada akhir biok (drag).

UNIVERSITASMEDAN.AREA
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| Working In Background

Pada tab Pointers, memungkinkan
anda untuk mengganti tampilan mouse
pointer. Cara mengganti mouse
pointer tersebut, pada Customize pilih
salah satu item, kemudian klik Browse
untuk mengganti style tersebut.

Pada tab Pointer Option, pengaturan
mouse yang dapat dilakukan sebagai
berikut:

T Endble poter Shadow

W Aow themes 1o change aiouse pointers

Pada Motion, pengaturan pergerakan
mouse pointer dapat dengan lambat
(slow) atau cepat (fast).

Pada Visibility, pengaturan mouse
pointer memberikan penampilan yang
menarik seperti penampilan mengikuti
jejak pergerakan mouse.

Show location of pointer when |
press the CTRL key, berfungsi untuk
memberikan  tanda  jika anda
menekan tombol CTRL pada
keyboard.

F. REGION AND LANGUAGE

Pengaturan Region and Language
mempengaruhi penampilan penunjuk
waktu yang sedang berlangsung sesuai
dengan format bahasa yang digunakan.

Untuk lebih detailnya anda dapat
memilih  Additional setting, untuk
melakukan perubahan-perubahan yang
anda inginkan.

/] Display porter tras

Shat 7

st e
Lo dore:

Bt day of wankc

Dot dde
Longane
Shoa s
Yo e
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G. WINDOWS EXPLORER

Ada beberapa langkah

mudah untuk menjalankan Windows
Explorer, antara lain:

1.

—_

. Atau tekan tombol Windows

Klik tombol Start Menu
Programs Accessories
Windows Explorer.

All

. Cara lain klik kanan tombol Start

Menu pilih Open Windows
Explorer.
. Cara lainnya Kklik icon folder

Windows Explorer yang terdapat
pada Taskbar.

BN
e

+E

AT
&t

R Rere

= ¥ i

pada keyboard.

Windows Explorer adalah
fasilitas yang disediakan Windows
untuk banyak hal salah satunya
adalah membuat Folder. Adapun
langkah-langkahnya sebagai
berikut :

1. Klik Local Disk (D:), lalu klik
menu New Folder yang terdapat
di atas Aplikasi, sehingga muncul
lcon New Folder pada halaman
Windows Explorer.

2. Lalu ganti kata New Folder

pada icon menjadi kata yang anda inginkan, seperti Nama dan NPM

lalu Enter.

. MENYALIN FOLDER ATAU FILE

Langkah untuk menyalin folder atau file adalah :

berikut:

Klik menu Edit  Copy, atau

. Tentukan atau pilih folder yang akan disalin.
. Lakukan perintah menyalin,dengan menggunakan salah satu cara

Tekan Ctrl + C pada keyboard, atau

Klik kanan Folder yang terpilih,

lalu pilih perintah Copy.

UNIVERSITAS MEDAN.AREA
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3. Kiik folder tujuan dimana hasil salinan akan ditampilkan.

4. Gunakan salah satu cara berikut untuk menampilkan hasil salinannya:
Klik menu Edit  Paste, atau
Tekan Ctrl + V pada keyboard, atau
Klik kanan folder tujuan, dan pilih perintah Paste.

I. MENGGANTI NAMA FOLDER ATAU FILE

Langkah untuk mengganti
nama folder atau file adalah :
1. Pilih folder atau file yang akan
diganti namanya.

?:1' Favorites

2. Kerjakan salah satu cara dibawah BE Desktcp :
lnl . Doweniosds - BUKU #RAKTEX
: ) . % Recent Plac Data Puskom
Klik menu File Rename, My Documente
Libraries Utilities
atau Documerts
Klik kanan folder atau file, dan & Music
. B Pictures
pilih Rename, atau B Videos
‘ Tekan F2 pada keyboard. ADY SATRIA
3. Ketikan nama penggantinya. e folger

Kemudian tekan Enter.

J. MEMBUAT SHORTCUT FOLDER ATAU FILE

Selain membuat shortcut
dari program, juga dapat membuat
shortcut terhadap folder yang telah
anda  miliki.  Langkah  untuk
membuat shorcut folder atau file
adalah sebagai berikut:

1. Tentukan folder atau file yang
akan dibuat shortcut.

2. Klik kanan folder tersebut,
kemudian pilih Send to
Desktop (create shortcut).

UNIVERSITAS MEDAN AREA
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K. MENCARI DOKUMEN

i Covmoads |

S W Conpmy F Cmon Biaent B O Dalam mencari
e folder atau file yakni dengan
ey cara sebagai berikut :

e 1. Buka jendela Windows

Expiorer, lalu tentukan
Drive (D:/) dimana biasanya
folder atau file tersimpan.
2. Lalu ketikan nama folder atau file yang ingin dicari di kotak index
search di sudut kanan atas, misalnya : Data Puskom.
3. Lalu tunggu sampai pencarian berakhir dan menemukan hasil folder
atau file yang di inginkan.

L. MENGETAHUI INFORMASI KOMPUTER

Untuk  mengetahui  informasi
tentang unit komputer, seperti kapasitas
Memory  (RAM),  Processor, edisi = T
Windows 7, dan sebagainya, adalah -
dengan langkah berikut:
Klik tombol Start, pilih Computer pada
jendela menu, lalu klik kanan, kemudian nmm———
pilih Properties.

M. TATA CARA MENUTUP WINDOWS 7

Untuk menutup Windows 7, langkah-langkah yang harus
dilakukan adalah sebagai berikut : Klik tombol Start, lalu pilih salah satu
perintah berikut :

UNIVERSITASMERANAREA
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. Shut

down,

semua aplikasi
unit komputer.

. Switch user, untuk pergantian
pengguna komputer tanpa harus
menutup program, maksud
pengguna disini adalah pengguna
yang mempunyai hak akses.

. Log off, untuk pergantian
pengguna  komputer  dengan
menutup program

. Lock, untuk mengunci Windows.
Jika ingin membukanya kembali,
maka harus memasukan

untuk  menutup
dan mematikan

Micrasett Word 2010
Micrasof PowesPoirt 2010
Micrsactt Excel 2010

@ Mazita Fiefox

3«5, becha Player Clensic
Google Crome
AtSony
/‘3’ Senactfren Connex EC1261-2 UL
=
Command Prompt

Calcutator

Password-nya terlebih dahulu, lalu tekan Enter.
. Restart, untuk menutup dan memulai kembali menjalankan Windows

7

. Sleep, komputer berada dalam mode penghematan power dan layan
komputer berubah menjadi gelap/mati.

. Hibernate,
program yang sedang berjalan.

untuk mematikan komputer tanpa menutup semua
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Microsoft Word
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MICROSOFT
WORD

A. MENGENAL MICROSOFT WORD

(i Word (MS Word) merupakan program untuk mengolah
Program ini bisa digunakan untuk menulis dokumen misalnya

karya tulis, skripsi, novel, dan sebagainya. Selain menulis dokumen, MS

Word juga dapat digunakan untuk bekerja dengan tabel, menulis teks

dengan kreasi, menyisipkan gambar, maupun yang lainnya.

Secara default tampilan area kerja program MS Word 2010 terdiri
atas Title Bar, Office Button, Quick Access Toolbar. Menu Bar, Ribbon.
Ruler, Status Bar, dan View Toolbar.

Quick Access Toothar Tab Titte Bar

Office Burton

Statns Bar ¥iew Toolbar

1. Title Bar (Bar Judul / Baris Judul)
Baris judul atau title bar merupakan bar yang menampilkan nama
dokumen yang aktif atau yang sedang dikerjakan. Gambar nama
UNIVERSITAS MEBAN-AREA
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dokumen di bar ini dapat digunakan untuk mengontrol dokumen yang
sedang diaktifkan apabila pengguna membuka beberapa dokumen
sekaligus. Dokumen yang aktif ini selalu ditampilkan dengan warna
menyala (tergantung warna gambar monitor/colors monitor) dan
wallpaper yang dimiliki.

2. Office Button (pada Office 2010) / File (pada Office 2010)

Tombol office atau File berisi perintah-perintah standar untuk
mengoperasikan file o<umen, seperti menyimpan dokumen, membuka
dokumen, menutup dokumen, mencetak dokumen, dan lain-lain.

3. Quick Access Toolbar (Bar Tool Akses Cepat)

Toolbar ini memiliki keistimewaan khusus dan terletak di bagian
sudut kiri atas lembar kerja. Isi tombol perintah dalam toolbar ini dapat
anda tambahkan beberapa tombol perintah lain yang sering anda
gunakan dalam toolbar ini.

4. Tab
Tab adalah bagian yang berbentuk tabulasi dan berisi serangkaian
group (ribbon) yang memuat beberapa tombol.

5. Group (Ribbon)

Group merupakan bagian yang terletak di bawah Tab dan berisi
tombol-tombol perintah untuk menjalankan proses tertentu dengan cara
mengklik tombol-tombol perintah tersebut.

6. Tombol Dialog

Tombol dialog adalah tombol dengan simbol anak panah yang
berada di bagian kanan nama Group. Tombol ini berfungsi untuk
membuka kotak dialog dari suatu group yang berisi perintah-perintah
yang lebih kompleks atau lengkap.

7. Status Bar (Baris Status)

Baris status berfungsi untuk memberikan informasi status posisi
insertion poin (cursor) layar sesuai dengan posisi halaman dan jumlah
halaman maksimal, hingga jumlah kata yang sudah digunakan dalam
dokumen yang akitif.

UNIVERSITASMEDANAREA



8. Scroll Bar

Scroll bar ditandai dengan bentuk garis yang dapat digulung secara
vertikal dan horizontal. Jadi scroll bar ini berfungsi untuk menggulung
lembar kerja ke atas dan ke bawah, serta ke kiri dan ke kanan.

9. Ruler

Ruler merupakan kotak pengukuran yang diletakkan secara
horizontal, yaitu di atas dokumen, dan secara vertikal, yaitu di sebelah
kiri dokumen. Ruler berfungsi untuk mempermudah melakukan
pengaturan letak halaman.

10. View Toolbar
View TOolbar berisi pengaturan jenis tampilan dokumen, antara lain:

a. Print Layout: memberikan tampilan sesuai hasil yang akan diterima
pada saat dicetak (default).

b. Full Screen Reading: memberikan tampilan halaman penuh.

c. Web Layout: memberikan tampilan sesuai hasil yang ditampilkan di
dalam jendela browser.

d. OQutline: memberikan tampilan sesuai heading di dalam dokumen dan
tingkatan di dalam struktur dokumen.

e. Draft.: memberikan tampilan yang berkelanjutan (menggabungkan
seluruh halaman seperti dalam satu gulungan). Tiap halaman
dipisahkan oleh garis titik-titik.

B. QUICK ACCESS TOOLBAR

Quick Access Toolbar adalah sebuah toobar yang dapat
disesuaikan yang berisi sebuah pengaturan command (perintah) yang
bebas pada Ribbon. Anda dapat memindahkan Quick Access Toolbar
dari satu lokasi kelokasi yang lain, dan anda dapat menambah command
pada Quick Access Toolbar.

Lebih detail lagi anda dapat melakukan modifikasi pada lembar kerja
Microsoft Word. Untuk melakukan setting tampilan lembar kerja Microsoft
Word dengan langkah sebagai berikut:
Klik tanda pilihan Customize Quick Access Toolbar — More
Command...
Atau klik kanan mouse pada salah satu Group - Customize Quick
Access Toolbar
Sehingga tampil gambar sebagai berikut:
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Keterangan:

1.

General berisi tentang
tampilan interface Microsoft S
Word seperti merubah style g
warna pada user interface e
option dan user name sebagai
identitas pengguna.

. Display berisi tentang tampilan

karakter-karakter spasi, OE2=
karakter tab, karakter paragraf
atau menambah informasi
tambahan pada file vyang
dicetak vyaitu pada print
document properties, dan lain-lain.
Proofing berisi tentang pemberian tanda pada ejaan (spelling). Pada
tombol AutoCorrect Option anda dapat melihat bagaimana penulisan
yang salah akan dikoreksi secara otomatis sesuai dengan sistem
penulisan yang benar (bahasa Inggris), automatic number list,
automatic bullets list dan lain-lain.

Save berisi tentang lokasi penyimpanan file, menyimpan secara
otomatis setiap berapa menit tergantung dari waktu yang ditentukan.
Language digunakan untuk menambah bahasa tambahan (selain
English) termasuk kepada tata bahasa, kamus (penulisan kata yang
benar).

Advanced berisi tentang pengaturan tampilan lembar kerja Microsoft
Word seperti menampilkan batas pengetikan, toolbar, pengaturan
ruler line, pengaturan nomor halaman dan lain-lain.

Customize Ribbon berisi pengaturan Ribbon dan Group.

Quick Access Toolbar berisi command atau perintah yang digunakan,
perintah-perintah tersebut dapat ditambah atau dikurangi sesuai
dengan keinginan anda.

Add-Ins untuk menambah perintah dan fitur baru.

. Trust Center untuk pengaturan keamanan dan privasi program

Microsoft Office.

C. MEMBUAT, MENYIMPAN, MENUTUP, DAN MEMBUKA DOKUMEN

Untuk membuat dokumen baru, dapat dilakukan dengan cara

berikut:

1.

Klik Tombol Office > New sehingga muncul jendela baru yang
menampilkan bagian New Document.
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2. Setelah itu pilihlah Blank
Document untuk membuat
dokumen. (Dapat juga memilih
salah satu dokumen template
untuk membuat dokumen baru
berdasarkan template yang
telah disediakan).

Di dalam Quick Access Toolbar juga terdapat tombol New yang
berfungsi untuk membuat dokumen baru tanpa melalui jendela baru.

Sebelum memulai dokumen,
sebaiknya atur properti terlebih dahulu.
Pengaturan properti mempengaruhi hasil
cetakan. Pengaturan properti dapat dilakukan
dengan mengklik menu Page Layout.
Kemudian pada ribbon Page Setup, klik
tombol dialog sehingga muncul kotak dialog
Page Setup. Kotak dialog ini terdiri dari tiga
bagian, yaitu Margins, Paper, dan Layout.

a. Margins: untuk menentukan batas atas

(Top), kiri (Left), kanan

(Right), dan bawah
(Bottom) dokumen, dan ada juga orientasi
kertas. Gambar 6 menunjukan margin
halaman.

b. Paper Size: untuk menentukan ukuran kertas
yang akan digunakan dengan memilih opsinya
pada menu drop-down. Jika menginginkan
ukuran kertas sendiri, dapat diisi nilainya
secara langsung pada kotak Width dan Pottom
Height.

Untuk menyimpan dokumen baru, secara default nama dokumen
yang dibuat akan berurutan, yaitu Document 1, Document 2, Document
3, dan seterusnya. Cara untuk menyimpan dokumen adalah sebagai
berikut:

1. Klik Office Button > Save atau Office Button > Save As sehingga
muncul kotak dialog Save As.

2. Didalam kotak dialog tersebut, lakukan pengaturan sebagai berikut:
a. Save in: tentukan lokasi folder tempat dokumen akan disimpan.
b. File name: ketikkan nama untuk identifikasi dokumen.
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c. Save as type: type dokumen, gunakan default yang diberikan,
yaitu Word Document.
d. Tombol Save untuk menyimpan dokumen tersebut.

Untuk menyimpan dokumen
lama yang telah diedit, klik Office
Button > Save. Apabila dokumen The file Doc2.docx already exists.
tersebut hendak disimpan dengan :
nama yang berbeda, klik Office Button le.}
> Save As sehingga caranya sama Save changes with a different name,
seperti  menyimpan dokumen baru. O Merge changes into existing fik.
Apabila dalam menyimpan dokumen,
nama yang digunakan sama dengan
nama yang sudah ada di dalam folder,
maka kotak konfirmasi seperti gambar berikut akan muncul.

Replace exiting file: menimpa file yang sudah ada dengan dokuman
baru.

Save change with a different name: menyimpan dokumen baru
denga nama lain.

Merge into exiting file: menggabungkan perubahan yang dilakukan
kedalam file yang sudah ada.

Setelah selesai mengedit dokumen dan memastikan sudah
menyimpannya, ada beberapa cara untuk menutup dokumen, yaitu:
1. Klik Office Button > Close.
2. Klik tombol Close Window yang terdapat dalam Title Bar.

Dokumen yang telah disimpan dapat dibuka dengan salah satu
cara berikut :
Klik Office Button > Open.
Klik tombol Open yang terdapat di dalam Quick Access Toolbar.
Sehingga muncul kotak dialog Open, kemudian pilih file dokumen
yang hendak dibuka.

D. MENULISKAN, MEMFORMAT TEKS DAN PARAGRAF
Pengetikan teks dimulai dari titik sisip (titik iterasi). Titik sisip
dapat dilihat dari garis hitam yang berkedip di dalam halaman dokumen.

Dalam mengetikkan teks, penekanan tombol Enter pada keyboard akan
membuat paragraf baru. Untuk membuat hasil yang maksimal, maka
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diperlukan pemformatan karakter, seperti menentukan jenis huruf, tipe
huruf, ukuran huruf, dan lainnya. Pemformatan karakter dapat diterapkan
sebelum ataupun sesudah pengetikan. Klik menu Home, kemudian pada
ribbon Font klik tombol dialog untuk melakukan pemformatan sehingga

muncul kotak dialog Font.

Font: untuk menentukan jenis huruf
yang digunakan.

Font Style: menentukan tipe huruf, yaitu
Regular (biasa), /talic (miring),

Bold (tebal), dan Bold [talic (tebal dan
miring).

Size: menentukan ukuran huruf.

Font Color: menentukan warna huruf.
Effects: untuk membuat efek-efek yang
akan diterapkan pada teks.

Preview: menampilkan contoh hasil
pengaturan format teks

Tabel di bawah ini memperlihatkan contoh-contoh = hasil

pemformatan teks dan penggunaan efek di dalam teks.

Format Karakter

Hasil Format Karakter

Regular contoh teks dengan efek

Bold contoh teks efek ‘

Italic contoh teks efek

Bold Italic contoh teks efek

Underline contoh teks efek

Bold-Italic-Underline contoh teks efek
efek

Double Strikethrough

Superscript contoh teks dengan efek

Subscript

Shadow

Outline contoh teks efek

Emboss contoh teks efek

Selain pemformatan huruf, juga ada pengaturan paragraf.

Perataan paragraf ada empat macam, yaitu rata kiri
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rata tengah (Center), rata kanan = (Align Right), dan rata kiri

kanan (Justified).
Pengaturan spasi baris adalah pengaturan jarak antarbaris di

dalam paragraf. Pengaturan ini dapat dilakukan dengan tombol
Line Spacing.

Menyisipkan tabulasi juga sering digunakan dalam membuat
dokumen. Contoh penggunaannya dapat dilihat pada Gambar berikut.

B 1z ez 4 s Cara paling mudah dalam

menggunakan tabulasi adalah dengan

NIM g 23059999 memposisikan pointer pada Ruler,
Nama - Patrick

kemudian klik pointer sehingga muncul

Fakultas  : Teknik ~ simbol tabulasi. Untuk menghapus

Jurusan @ Sistem Informast  tapjasi, seret simbol tabulasi keluar

Ruler. Ada lima alignment yang

dapat dipilih, yaitu Left, Center, Right, Decimal dan
— Bar.

E. MENGGUNAKAN TABEL

Pada umumnya, penyisipan tabel ke
dalam dokumen berfungsi untuk mendukung
penjelasan/uraian dokumen. Untuk membuat
tabel, pilih Insert, pada ribbon pilih Table,  Mmberofcolms:
kemudian pilih ukurannya. Dapat juga dengan M ofns:
cara, pilih Insert > Table > Insert Table,  Auoftbehavior

kemudian akan muncul dialog box seperti © Fixed
berikut : O AutoFit to contents

O AutoFtt to wingdow
Number of columns : untuk menentukan
jumlah kolom, sebagai contoh isikan 2.
Number of rows : Untuk ‘menentukan
jumlah baris, sebagai contoh isikan 3.
Autofit behavior : untuk pengaturan lebar kolom.

O remember dimensions for new tables

Cancel
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Teks dapat langsung diketikkan pada sel dalam tabel, hasil dari
contoh akan seperti berikut :

Untuk membuat tabel menjadi bervariasi, dapat dilakukan
dengan klik tabel yang sudah dibuat, kemudian pada menu akan muncul
dua menu tab baru, yaitu design dan layout. Pilih design untuk
membuat tabel bervariasi.

JADWAL PRAKTIKUM
SENIN PENGANTAR ILMU KOMPUTER

MICROSOFT OFFICE 2010

Atau dapat diatur juga mengatur posisi teks dalam kolom,
mengurutkan data, dan sebagainya yang dapat anda lakukan dengan
memilih menu tab layout.

F. MENYISIPKAN OBJEK

1. Menyisipkan Gambar

Gambar dapat disisipkan ke dalam dokumen.
Gambar yang disisipkan dapat berupa file gambar atau
kumpulan gambar (clip art) yang telah disediakan
program MS Word. Untuk menyisipkannya, klik tab
menu Insert > Clip Art. Pada bagian Search for:
dapat diisi dengan kata petunjuk yang berhubungan,
misalnya PC.

Untuk menyisipkan gambar yang diinginkan,
tinggal klik gambar yang diinginkan. Berikut ini contoh £ TT075 e
hasilnya : s

Gambar dapat disisipkan ke dalam dokumen.
Gambar yang disisipkan dapat berupa file gambar
atau kumpulan gambar (c/ip art) yang telah
disediakan oleh MS Word
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Untuk menyisipkan gambar dari file, pilih tab menu Insert >
Picture, kemudian pilih gambar pada directory penyimpanan file gambar.

2. Menyisipkan Objek AutoShape

AutoShape adalah objek-objek dengan bentuk tertentu yang
dapat disisipkan ke dalam dokumen. Objek-objek tersebut antara lain
bentuk garis, lingkaran, persegiempat, dan lainnya. Untuk
menyisipkannya, pilih tab menu Insert > shapes kemudian pilih bentuk
objek yang diinginkan. Objek — objek tersebut juga dapat disisipi teks,
seperti contoh :

3. Menyisipkan Simbol

Di dalam dokumen sering anda jumpai beberapa simbol seperti
©,®, ™  dan lain sebagainya. Cara untuk menyisipkan simol — simbol
tersebut, pilih tab menu Insert > Simbol
kemudian pilih more simbols.

4. Menyisipkan Diagram

Untuk membuat diagram struktur
organisasi seperti contoh di bawah, pilih tab
menu Insert > smart art kemudian pilih
organization chart.

3™
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Untuk membuat diagram seperti contoh dibawah, pilih tab menu
Insert > Chart, kemudian ganti nilai sesuai dengan yang dikehendaki.

50

0
1st 2nd 3¢d 4th
Qtr Qtr Qir Qtr

Untuk mengganti tipe diagram dapat dilakukan dengan klik kanan

diagram, kemudian pilih edit, lalu pada menu pilih edit chart
kemudian pilih tipe yang dikehendaki.

5. Menyisipkan WordArt

Teks yang dibuat dengan WordArt akan tampak lebih bervariasi.
Salah satu contoh penggunaan WordArt adalah di bawah ini:

Cara menggunakannya, pilih tab menu Insert pilih wordArt,
kemudian pilih tipe yang dikehendaki, setelah itu masukkan teks yang
ingin di tulis dengan wordart.

6. Menyisipkan Nomor Halaman

Penomoran halaman dapat dilakukan
secara praktis. Caranya dengan memilih tab
menu Insert > page number, kemudian pilih
letak nomor halaman sesuai dengan
keinginan, sebagai contoh pilih Bottom of
page, maka akan muncul pilihan tipe.

i

7. Menyisipkan Header and Footer
Fasilitas Header  and Footer

digunakan untuk membuat catatan kaki,

penomoran halaman, dan yang lainnya. Untuk masuk ke bagian ini, pilih
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Insert kemudian tinggal pilih header atau footer. selanjutnya asukkan
teks untuk header dan footer. Pada saat mengisi teks untuk header atau
footer, bagian teks utama akan disable, atau berwarna redup dan tidak
dapat di edit. Untuk mengedit main teks, pilih close header and footer
pada ribbon.

8. Borders, Shading, dan Drop Cap
Beberapa tambahan dalam membuat dokumen tampak lebih
menarik seperti contoh dibawah ini:

Microsoft Word (MS Word) merupakan program
untuk mengolah kata. Program ini bisa digunakan
untuk menulis dokumen misalnya karya tulis,
skripsi, novel, dan sebagainya. Selain menulis
dokumen, MS Word juga dapat digunakan untuk
bekerja dengan table, menulis teks dengan kreasi,
menyisipkan gambar, dl|

Untuk bagian MICROSOFT OFFICE 2010 yang berwarna biru
serta memiliki bayangan merah, dapat dilakukan dengan memblok text
tersebut, pilih Page Layout > Page Borders, kemudian pilih tab Border,
pilih Shadow kemudian pilih warnanya. Selanjutnya pilih tab Shading
kemudian pilih warnanya. Untuk huruf pertama (M) yang berukuran besar
dibuat dengan cara, pilih Insert > Drop Cap kemudian pilih jenis yang
dikehendaki.

9. Membuat Kolom

Untuk membuat kolom seperti contoh di bawah ini, pilih Page
Layouts » Columns kemudian tentukan banyaknya kolom yang ingin
dibuat. Jika ingin memodifikasi tampilan teks model kolom, anda dapat
memilih More Columns ...

Sehingga tampil gambar seperti berikut:
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7] Equa column width

Agply to!
Microsoft Word (MS menulis dokumen digunakan untuk
Word) merupakan musalnya karya tulss, bekerja dengan tabel,
program untuk skripsi, novel, dan menulis teks dengan
mengolah kata. sebagainya. Selain kreast, menyisipkan
Program i bisa menuls dokumen. gambar, dlL.
digunakan untuk MS Word juga dapat

10. Menyisipkan Rumus (Equation)
Untuk membuat rumus (equation) melalui langkah-langkah
sebagai berikut :
Klik Ribbon Insert - E

Contoh : ( ) ()
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G. TABLE OF CONTENT (DAFTAR ISl)

1. Membuat Daftar Isi Otomatis

Anda dapat membuat daftar isi dengan menggunakan heading
styles, — misalnya Heading 1, Heading 2, and Heading 3 — untuk teks
yang anda inginkan termasuk ke dalam daftar isi. Microsoft Office Word
mencari headings tersebut dan kemudian memasukkan ke daftar isi

dokumen anda.

Ketika anda membuat daftar isi menggunakan cara ini, anda dapat meng-
update-nya secara otomatis jika anda membuat suatu perubahan dalam

dokumen.

Microsoft Office Word 2010 menyediakan sebuah gallery of automatic
table of contents styles, tetapi jika ingin membuat suatu style yang baru,

silahkan klik tanda More pada Group Styles :

= - -
&

Fanfeeronc 12 - A A A H E-E
oo
Pt
T Feomn e

Pilih Save Selection as a New Quick Style..., lalu buat nama-nama style

yang baru.
Cara membuat daftar isi
secara  otomatis  sebagai
berikut:

Tandai teks yang akan

dijadikan table of contents
Klik table of contents style
yang diinginkan dari
gallery of options.

'z 3
BBk B¥-A EEBW = XD

A ACd AaBRG aczbee RAH

R3] mestng Subbie tm,,, o &

H % sl ased 4aBbe s AdB s

tent (Dalt

st Heading? k.3 Saviiie et £
4aBCe! iaBbCe 8aBC¢ 4aBVC JeBbCc A3(C AMEX(C
bty btewet.  Beng Qe wned. Yt R blemed,
A4BBCC 2aB5Cc]
Soskie TEdPuy.

‘Sae Salactien a1 8 New QUinh Syt

'mhim% Con Femating

RUIS Saiiha

)

Langkah-langkah dalam membuat daftar isi secara otomatis:

1. Blok teks (judul atau subjudul) yang akan dijadikan Daftar Isi.
2. Pada tab Home, pada group Styles, klik style yang anda

inginkan.
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aaBbCeD: AaBbCen AaBhC: AaBbCce AHB : %

fHommal  THe Spact.. Heading i Heading 2 Titte - Change
Styles
Styles ™

Sebagai contoh Heading 1 atau style yang anda buat sendiri melalui
cara yang sudah dijelaskan di atas.

3. Pada tab References, pada group

Table of Contents, kik Table of e
Contents, dan kemudian klik style @ update Table
table of contents yang anda inginkan. C};‘t"e‘“n‘::'

Tabie of Cantents

Update Table Of Contents

Jika anda menambah atau menghapus headings atau bagian
daftar isi yang lain pada dokumen anda, anda dapat meng-update
dengan cepat daftar isi anda.

Langkah-langkahnya adalah:

1. Pada tab References, dalam group
Table of Contents, klik Update Table.
2. Klik Update page numbers only or

Update entire table. JLLB

Contents
Tatale of Contents

Menghapus Table Of Contents

1. Pada tab References, e
dalam group Table of (3 Updste Table e A —-
Contents, klik Table of  Twi=c — -
Contents. Table of Contents

2. Klik Remove Table of
Contents. o
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2. Membuat Daftar Isi Secara Manual

Selain memanfaatkan styles untuk membuat daftar isi secara
otomatis, anda juga dapat membuat daftar isi secara manual. Dengan
memanfaatkan tanda pemberhentian tabulasi (tab stop position) pada
ruler anda dapat menghasilkan daftar isi yang tidak kalah rapinya dengan
membuat daftar isi secara otomatis.

Mari anda ikuti langkah-langkah berikut ini:
1. Arahkan mouse pointer pada ruler dan beri tanda left tab seperti
terlihat pada ambar berikut:

TRt 2 0 & "

A ORISR %o«
B Prempis B A Y% .-

2 AaRut asunce AAL s
mm E e g WSIL TN G Mt

2. Untuk melakukan setting, double klik tanda
pemberhentian tabulasi tersebut, seperti terlihat
pada gambar berikut:

3. Pada Tab stop position, pilih angka yang akan
anda setting menjadi tanda titik-titik dan setting
sedangkan bagian yang lain setting sesuai
keperluan.

4. Kemudian anda akan mendapatkan contoh
daftar isi secara manual tersebut.

LaC
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H. MAIL MERGE

Mail merge adalah salah satu fasilitas yang digunakan untuk
membuat sertifikat/surat/undangan yang akan ditujukan ke berbagai
orang/alamat yang berbeda. Mail merge membutuhkan 2 file yang
digabung, yaitu file yang berisi kerangka surat biasa disebut Main
Document, sedangkan file yang lain adalah file yang berisi data-data
(alamat yang dituju) biasa disebut Data Source.

Mail merge dapat menggunakan berbagai macam data. seperti data
Microsoft Word, Microsoft Access dan Microsoft Excel.

Langkah-langkahnya :
Klik Ribbon Mailings ~ Start Mail Merge ~ Step by Step Mail Merge
Wizard...

B Directory
- J—

.8. L
Mail merge adalah salah satu fasilitas yang digunakan untuk
embuat surat/undangan yang akan ditujukan ke berbagai alamat yang

mebmde BAnif mmavan mammabibriblinm D Ffa rame dimale o emibe Gla vean

Pada Select document type, pilih Letters, lalu klik Next: Starting
document

10f6
#  Next: Starting

Pada Select starting document, pilih Use the current document.

@ Next: Select reapients
¥ Previous: Select doament type
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Pada Select recepients, pilih Type a new list, jika data belum
pernah diketik, jika sudah diketik klik Browse.

Ste 3of6

-

= @ Next: Write letter

@ Previous: document
¥

Anggap belum pernah diketik, klik Create, sehingga tampil kotak
dialog berikut :

Mengganti nama field, klik
Customize Columns.
- Remove nama field lama dan
ketik nama field baru.
- Setelah data dientri, simpan data
ke media penyimpan data.
- Untuk mengisi nama field ke
Main Document, klik Ribbon
Maillings - Insert Merge Field.

Mencetak hasil penggabungan klik Finish & Merge.

Kemudian pilih Print Documents ..... sehingga tampil gambar
berikut:

iy Ruses v M o€ L. ]

= B Malos Pews P vecistert,
Envetopes Lsbels  s5tadt Mait  Selest Edn h Address Greeting Insent Mecge Rk
Aserde © Renpienis  Reciphent List ; Mg . Blodt. Line Freia + 4 Ao Check fo1 irers | dtesge -
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to Printer

Print records

Current record
From: To:

Pilihan All, mencetak semua data (record) yang dientri.

Pilihan Current record, mencetak data (record) yang sedang tampil
pada dokumen.

Pilihan From, mencetak record tertentu misalnya:

Print records

Current record
‘@ From: To:
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I. MENCETAK KE PRINTER

Mencetak ke printer maksudnya adalah mencetak teks seperti
yang ada pada layar monitor ke kertas.

Langkah-langkahnya :
Klik File atau Office Button — Print

Name: Canon Inkjet MP140 series
Status: idle

Type: Canon Inkjet MP140 series

Where:  USBOOL [~ Print to file
Comment: [~ manual duplex

range

Properties

Fing Printer...

@ Al

Number of copies:

 Current page  Selection
C Pages:

Type page numbers andfor page
ranges separated by commas counting
from the start of the document or the
section. For example, type 1, 3, 5-12 or
plsl, p1s2, pls3-p8s3

Print what: Document
Pages per sheet: 1 page

Scale to paper size:

Optidns... Cancel

Tentukan nama printer dan halaman yang akan dicetak kemudian klik
OK.
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LATIHAN 1.

Menguak Keindahan Bawah Laut Bunaken
By :

Pulau yang terletak di Barat Laut kota Manado ini,
memiliki keaneka ragaman kehidupan yang sangat
besar, karena pulau-pulau ini merupakan tempat

dimana  plankton-plankton  yang

merupakan

makanan semua mahluk hidup biota laut naik ke

permukaan. Karena banyaknya jumlah plankton
yang naik ke atas permukaan laut, banyak biota laut yang memilih
tempat ini sebagai rumahnya. Snorkler dan diver bisa melihat
70%-80% jenis biota laut yang ada di dunia, tujuh dari delapan
spesies dari kerang raksasa dapat diketemukan di Bunaken.

Di Bunaken, banyak sekali yang dapat dilakukan
untuk menikmati keindahan bawah lautnya, mulai dari
melihat hanya dari glass bottom boat, snorkeling dan
personal favorite, scuba diving. Tidak heran jika scuba
diving merupakan kegiatan yang paling
menyenangkan bagi semua turis. Disini para turis bisa
menemui hampir 70-80% ikan dan terumbu karang
yang ada di dunia.

Keindahan terumbu karang di Pulau Bunaken
juga masih sangat bagus. Mereka tidak
mengalami proses pemutihan atau coral
bleaching, efek dari badai el-nino sehingga
warna dan keindahannya tetap terjaga. Selain
faktor alam, kondisi karang Bunaken juga di jaga

oleh warga-warga sekitar yang berpatroli tanpa kenal lelah untuk
menjaga keutuhan taman laut ini. Mereka menyadari, tanpa
karang laut yang sehat maka mereka akan kehilangan mata
pencaharian yang baik. Kesuksesan taman laut Bunaken sekarang
diikuti oleh semua taman laut yang bermunculan di Indonesia.

NB: Tugas > Download File Proposal, buat No. Halaman dan

Daftar Isi
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LATIHAN 2.
DAFTAR ISI
Halaman

Kata Pengantar .........cccooooviiiiiiiiiieieee e i
Daftar IS .o i
Daftar Tabel ..o e iii
Daftar Gambar ..........cccooiiiiiii e, X iv
BAB |.  PENDAHULUAN ..o 1
A. LatarBelakang .........ccoooovvveeiiieieeeeciie e 1
B. Tujuan Penelitian ...........cccooooiiin, 8
C. Manfaat Penelitian ...........ccoevivviiiiiiieeee, 9
BAB ll.  LANDASAN TEORITIS .....ccoiiiiiiieeeeeee e, 10
A. Kecenderungan Sres .........ccccccveveeiiiniaineenn. 11
1. Pengertian Kecenderungan Stres ............ 11
2. Akibat Stres ..o 15
3. Faktor-faktor Penyebab Timbulnya Stres . 19
B. SIKGP oo 27
1. Pengertian Sikap ..., 27
2. Ciri-Ciri SIKap ...coovvveiieiiiee e 32
BAB Ill.  METODE PENELITIAN ..o 36
A. ldentifikasi Variabel Penelitian ..................... 35
B. Metode Pengumpulan Data ...........ccccceiieee 45

Buatlah rumus-rumus berikut ini :
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LATIHAN 3.

UNIVERSITAS MEDAN AREA
PUSAT KOMPUTER

JI. Kolam No. 1 Medan Estate 061-7366878, ~~ "~ Medan 20224

Nomor
Lamp.
Hal

Kepada :

Medan, 20 November 2012
0101/H/11.1.f/12

Pelaksanaan Praktikum Komputer

Yth. Wakil Dekan | Fakultas ........
Universitas Medan Area
Medan

Dengan hormat,

Sehubungan dengan akan dilaksanakannya
Praktikum Komputer, maka dengan ini kami
beritahukan kepada Saudara bahwa jadwal praktikum
telah kami susun sesuai dengan permintaan
mahasiswa yang bersangkutan, adapun jadwal-jadwal
tersebut adalah :

NO GROUP HARI BELAJAR
Group A Senin & Kamis

2 Group B Selasa & Rabu
3 Group C Selasa & Jum’at
4 Group D Rabu & Jum'at
Group E Kamis & Sabtu

Demikianlah kami sampaikan, atas perhatian Bapak
diucapkan terima kasih.

Ka. Puskom
Universitas Medan Area

Sutrisno, S.T., M.T.
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LATIHAN 4.

STRUKTUR ORGANISASI
UNIVERSITAS MEDAN AREA

BPH KOPERTIS
UNIVERSITAS WILAYAH I
REKTOR
SENAT DEWAN
BAAP BAU
DEKAN LP LPPM
FAKUILT
PROGRAM UPT
STUDI
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LATIHAN 5.

UNIVERSITAS MEDAN AREA
PUSAT KOMPUTER DAN BAHASA

Sertifikat

Diberikan Kepada:
«Nama»
NPM. : «NPM»

Yang Telah Melaksanakan Praktikum Komputer di Pusat Komputer dan Bahasa
Universitas Medan Area Tanggal 5 Januari 2013 - 31 Februari 2013
Dinyatakan Lulus dengan Nilai «Nilai_Angka» («Nilai_Hurufy)

MATERI
Microsoft Microsoft Microsoft Microsoft Photoshop
Windows Word Excel Power Point

Medan, 22 Maret 2013
Instruktur, Kepala Pusat Komputer & Bahasa

Mhd. Ramadhan Romly, S.T. Sutrisno, S.T., M.T.

UNIVERSITASMEDAN AREA



Data Mail Merge

is the list of recipients that will be used in your merge. Use the options below 0 add to or change your list. Use the
cheddoxes to add or remove redpients from the merge. When your kst 1s ready, dick OK.

Data Sestifikat.mdb [V ANTIEN ARIES TANTY... 12.832.0038

Data Sertifikat.mdb [V SUTRIA KUMALA 128320088 60 C+
Data Sertfikat.mdb [V NURULAZMI 128320034 70 B
Data Sertifikatmdb [V MUHAMMAD FADLI 128320084 85 A

Data Source Refine reapient bst

"ter...

UNIVERSITAS MEBAN-AREA
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Microsoft Excel

Selamat Belajar. .... ..

UNIVERSITASMERAN ARFA
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MICROSOFT
EXCEL

A. MENGENAL LEMBAR KERJA EXCEL

Mircrosoft Excel merupakan program aplikasi spreadsheet (lembar
kerja) yang digunakan untuk membantu dalam menghitung,
memproyeksikan, menganalisa dan mempresentasikan data. Pada saat
kita menjalankan program aplikasi Excel 2007, sebuah buku kerja
(workbook) baru yang masih kosong otomatis akan ditampilkan, seperti
gambar berikut :

Lembar kerja Microsoft Excel terdiri dari kolom A sampai XFD
dan baris terdiri dari baris 1 sampai 1.048.576. Perpotongan antara baris
dan kolom disebut sel (Cell). Sel diberi nama menurut posisi kolom dan
baris pada lokasinya. Sebagai contoh Sel BS adalah perpotongan antara
kolom B dan baris 5.

UNIVERSITASMERAN-AREA
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Range adalah sekumpulan sel yang terdiri dari beberapa kolom atau
beberapa baris atau beberapa kolom dan beberapa baris. Misalnya
A2:G2, C2:C10, A2:F5.

B. MENYIAPKAN LEMBAR KERJA BARU

Untuk menyiapkan lembar kerja baru dengan menggunakan
langkah-langkah berikut :

1. Klik File atau Office Button , kemudian Klik NEW dan tampil
gambar berikut :

2. Kemudian pilih Blank Workbook — Create atau klik dua kali pada
Blank Workbook.

Atau dapat juga menggunakan perintah CTRL — N untuk membuka
lembar kerja baru tersebut.

C. MENYIMPAN LEMBAR KERJA

Untuk menyimpan lembar kerja dengan langkah sebagai berikut :

1. Klik File atau Office Button kemudian Klik SAVE atau SAVE
AS dan tampil gambar berikut :

UNIVERSITASMEDAN AREA
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2. Tentukan pada Directory mana data akan disimpan, kemudian buat
nama file pada File Name dan tekan tombol ENTER.

Atau gunakan tombol CTRL -~ S untuk menyimpan data tersebut.

D. MEMBUKA LEMBAR KERJA YANG TELAH DISIMPAN

Untuk membuka lembar kerja yang telah disimpan dengan

langkah sebagai berikut:

1. Klik File - Office Button

gambar berikut :

R braries
Doasments
b Music
B Pictures.
B videas

aw Data (03
g Muttimedia (&

kemudian Klik OPEN dan tampil

Dacuments liwrary
Includes. 4 locatinns

Date modified

4 My Doaments (9)

CaUsersams

&) My Dat Sousces
OneNcte Notehooks
PELATIHAN

5. safetiet Seatiet

& Updater

Bahan EHARw

BB HIT AL Fietol

A7 448 PR

UNIVERSITAS MEDAN AREA
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2. Tentukan Drive atau Directory tempat penyimpanan data, kemudian
klik dua kali pada File yang akan dibuka.

Atau dapat juga menggunakan pertintah CTRL — O untuk membuka file
dimaksud.

E. DATA MICROSOFT EXCEL

Data yang dapat dimasukkan ke dalam lembar kerja (worksheet)
dapat berupa :

- Teks (text) yaitu jenis data berupa huruf atau karakter lain yang tidak
dapat digunakan untuk operasi aritmatika. Misalnya : DAFTAR, X, Y,
dan lain-lain.

- Nilai (value) yang terdiri dari angka (numerik) dan rumus (formula),
yaitu jenis data yang dapat digunakan untuk operasi aritmatika.

- Tanggal (Date), contohnya : 6/4/2011 dan

- Waktu (Time), contohnya : 22:15

F. MEMBERIKAN GARIS PADA TABEL

Pada lembar kerja Microsoft Excel terdapat garis-garis bantu
atau yang disebut gridlines. Memberikan garis pada tabel dengan
langkah sebagai berikut :

- Klik Ribbon Home — Format, kemudian tampil gambar berikut :

format Cells
tine Presets

Styte:

Hane Qutling nade

Lolor:

The salested sorder style can be applied by clicking the presets, preview Glagram or the buttens above,

- Pilih style garis jika ingin merubah tampilan garis.
- Kemudian pilih Border untuk membuat garis yang diinginkan.

UNIVERSITAS I\/I'E‘BZN#REA



G. OPERATOR MATEMATIKA

1. Operator Aritmatik
Dalam lembar kerja excel operator aritmatik dilambangkan
seba ai berikut :

__"____; Pangkat (Eksponensial)__: Simbol di atas tombol angka 6 ___
... Perkalian . Simbol di atas tombol angka 8 ___|
_._l____rPembagian___________ :Simbolgarismiring ___________|
___*+____,Penjumlahan = S e L) R
....m.....Pengurangan_ e

+ Mendahulukan O erasi He

Contoh : =5*23 hasilnya adalah 40

2. Operator Relasi atau Pembanding
O erator RelasilPembandin dilamban kan seba ai berikut :

_______ 4 - R -
o> pte—tbesar LT T . o o o
__.<___. lLebihkecil I e

>= ' Lebih besar sama : Tanda lebih besar dan sama
_________ ydengan _______________.dengan_ . _.
<= ! Lebih kecil sama dengan ;TTanda lebih  kecil dan sama
_________ Ciiiiiiieeo_____idengan .
<> ' Tidak sama den an ' Tanda lebih besar dan lebih kecil
3. Operator Logika
O erator lo ika terdiri dari :
| SIMBOL «+  ARTI ,
and dan ¢ Digunakan untuk kedua atau lebih syarat
......... Loo__._____.fepenuhi .
or ?atau ;rDigunakan untuk pilihan salah satu syarat
: » terpenuhi

H. FUNGSI STATISTIK

Banyak sekali fungsi statistik yang dapat kita sajikan di dalam

lembar kerja Microsoft Excel, tergantung dari keperluan pengolahan data.
UNIVERSITAS MERAN-AREA
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Fungsi statistik tersebut dapat kita lihat melalui perintah klik Ribbon
FORMULAS - INSERT FUNCTION, dan pada Or Select a Category :
Statistical.

Select a function:

AVERAGE
AVERAGEA
AVERAGEF
AVERAGEIFS
BETABIST

AVEDEV(numberi;number2;...}

Returns the average of the absolute deviations of data points from their mean. Arguments
can be numbers or names, arrays, ar references that contain numbers.

Beberapa contoh fungsi tersebut adalah :

AVERAGE(RANGE), digunakan untuk mencari nilai rata-rata suatu
range.

COUNT(RANGE), digunakan untuk mencari jumlah data pada suatu
range.

MAX(RANGE), digunakan untuk mencari nilai tertinggi suatu range.
MEDIAN(RANGE), digunakan untuk mencari nilai pertengahan suatu
range.

MIN(RANGE), digunakan untuk mencari nilai terendah suatu range.
MODE(RANGE), digunakan untuk mencari nilai yang sering muncul
pada suatu range.

SUM(RANGE), digunakan untuk mencari jumlah suatu range.
STDEV(RANGE), digunakan untuk mencari simpangan baku suatu
range.

I. FUNGSI LOGIKA IF

Fungsi logika IF digunakan untuk memilih satu dari dua pilihan

atau lebih berdasar pengujian logika.

UNIVERSITASMEDAN AREA
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Bentuk penulisannya :

=|F(Uji_Logika;Nilai_jika_benar;Nilai_jika_salah)

D E
3 NO NAMA NILAt  KETERANGAN |
4 ROSA 80 LULUS
5 DIKA 75 LULUS
6 3 |PUTRA 50 GAGAL

Mengisi Keterangan dengan rumus sebagai berikut :
=|F(C4>=60;JLULUSI;[L)GAGAL)
J. FUNGSI TEKS

Fungsi teks digunakan untuk menuliskan sebagian teks pada sel
tertentu, yang terdiri dari LEFT, MID, dan RIGHT.

Contoh .
3 NO KODE WILAYAH| KODE BRG JENIS
4 1 DS101E DS 101 E
5 2 MD200L MD 200
6 SB2508 S8 250 B
7
8

UNIVERSITASMEDAN AREA
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Mengisi Wilayah vyaitu dua karakter awal dari KODE, rumusnya
=LEFT(B4;2)
Mengisi Kode Brg yaitu tiga karakter ditengah dari KODE, rumusnya
=MID(B4;3;3)
Mengisi Jenis vyaitu satu karakter akhir dari KODE, rumusnya
=RIGHT(B4;1)

K. FUNGSI PEMBACAAN TABEL

Fungsi pembacaan tabel digunakan untuk menyelesaikan
persoalan yang menggunakan tabel bantu. Fungsi ini dapat menjadikan
rumus menjadi lebih sederhana dan tidak terlalu panjang.

Fungsi pembacaan tabel terdiri dari :

- VLOOKUP(Nilai_kunci;Tabel_bantu;Nomor_index_kolom)
digunakan untuk membaca tabel bantu yang disusun secara vertikal,
dimana :

Nilai_kunci adalah syarat yang digunakan untuk pembacaan tabel.
Tabel_bantu adalah tabel yang disusun secara vertikal dan tabel ini
nantinya harus diabsolutkan (F4).

Nomor_index_kolom adalah angka yang menunjukkan pembacaan
tabel yang dimulai dari angka 1 .

Contoh :
GOL| HONOR | TUNJANGAN
A 900.000 150.000
B 1.000.000 175.000
C 1.100.000 200.000
3

- HLOOKUP(Nilai_kunci;Tabel_bantu;Nomor_index_baris)
digunakan untuk membaca tabel bantu yang disusun secara
horizontal, dimana :

Nilai_kunci adalah syarat yang digunakan untuk pembacaan tabel.
Tabel_bantu adalah tabel yang disusun secara horizontal dan tabel
ini nantinya harus diabsolutkan (F4).

Nomor_index_baris adalah angka yang menunjukkan pembacaan
tabel yang dimulai dari angka 1 .

UNIVERSITASMEDAN AREA
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Contoh :
GOL A 1
HONOR 900.000 | 1.000.000 | 1.100.000 |2
TUNJANGAN | 150.000 175.000 200.000 |3

L. GRAFIK

Grafik mempresentasikan data dalam bentuk gambar.

Prosedur dalam membuat grafik sebagai berikut :

1.

Klik Ribbon INSERT, lalu pilih grafik yang dikehendaki yang terdapat
pada Groups Chart.

o HHOD

ol b fuer S DEe M loemed Cawen Mo B 3v Awme e OBe e (MM WRsE g KRR Tt Shadn Wadtd Sese O (ot Geddl
Selanjutnya di dalam groups chart terdapat beberapa macam-macam
grafik antara lain Grafik tipe kolom (column chart), Grafik tipe garis
(line chart), Grafik tipe kue (pie chart), grafik tipe batang (bar chart),
Grafik tipe area / wilayah (area chart), Grafik tipe XY (Scatter Chart),
Grafik tipe saham (stock chart), Grafik tipe permukaan (surface
chart), Grafik tipe cincin (doughnut chart), Grafik tipe lingkaran yang
menggelembung (bubble chart), Grafik tipe radar (radar chart).
Sebelum membuat grafik dalam bentuk apapun yang pertama adalah
anda harus membuat data yang ingin dimasukkan ke dalam grafik.
Seperti Gambar di bawah.

o C 0 B
1 JUMLAH MAHASISWA BARU UMA
2008 - 2009 =

i 500

4 FAKULTAS 2008 2009 400

5 Teknik 245 345

6 Pertanian 159 265

7 Ekonomi 332 459

8 Hukum 276 305

9 lisipol 178 267

10 Psikologi 369 498

11 Biologi 207 354

12
Fakultas

UNIVERSITAS MERAN AREA
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M. MENYISIP MATA UANG DAN PEMISAH RIBUAN

Kadangkala kita ingin
menyajikan angka dengan mata

uangnya sekaligus, adapun
langkah-langkahnya sebagai
berikut :

-  Klik Ribbon Home - pada

Group Cells pilih Format -
Format Cells

Pilih Currency atau Accounting
untuk menentukan mata uang
nya.

ot | nagvmesr | o | oo | | erescnan

Qetems piaces: S
Swren. R

N. MENGGUNAKAN FITUR SPESIAL MICROSOFT EXCEL

1. AutoComplete (Memasukkan Data Terduplikasi)

Fitur AutoComplete membuat mudah untuk memasukkan teks
yang mirip/sama di dalam kolom. Disamping mengetik item teks berkali-
kali, kita hanya perlu mengetik satu kali di dalam sebuah kolom.

Excel Options

g Poputar £diting options

Formulas ij After pressing Enter, Move seleckon

Brosting Direction:

Save Automatically msert a decimal point
Places:

E Enable fill handie and celi grag-and-drop

Custauze

Add-ins

Trust Cente

Reesourcas

Alent the user when a potentially lime consuming operation accurs

When this nymber of cells (in ¥hausands} is affeced;

LUse system separalors

Reamal somarate:

UNIVERSITAS MEDAN-AREA
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2. AutoCorrect (Membetulkan Ejaan)

AutoCorrect adalah fitur yang secara otomatis mengkoreksi hal-
hal yang berkaitan dengan ejaan. Jika kita secara tidak sengaja
mengisi/mengetik ( tehi! kedalam worksheet Excel secara otomatis
merubah pengejaan menjadi < ithe .

Temem

3. AutoFill (Data Berurutan / Berulang)

AutoFill memungkinkan kita untuk mengisikan data yang
berurutan secara otomatis. Ketika Sequence dimula, AutoFill akan
menganalisa dan melanjutkannya. Langkah-langkahnya sebagai berikut :
1. Untuk mengisi range dengan angka-angka sequensial, ketik angka—
angka di dua sel pertama.

2. Blok dua sel tersebut, kemudian arahkan mouse pointer ke Fill
Handle (pointer akan berubah menjadi tanda silang).

3. Tarik tanda silang tersebut ke akhir yang diinginkan.

1 DAFTAR MAHASISWA PRAKTIKUM
2 UNIVERSITAS MEDAN AREA

NO NAMA NPM
1
6 2

UNIVERSITASMEDAN AREA
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4. Sortir Data

Untuk menampilkan data yang lebih rapi dan mudah dibaca oleh
siapa saja, perlu dilakukan sortir data atau mengurutkan data dengan
perintah sebagai berikut :

g4 sen |

Klik Ribbon Data — Sort

Contoh :

NAMA ALAMAT
RISKY TORES JI. Cempaka Raya 20
2 |OKTO CAPERIUS Jl. Asoka 13
IRFAN MAHDIN  JI. Kenanga Raya 45
4 |KIM KURNIA JI. Angrek 9
GONZALES JI. Kebon Jeruk 23

w

UNIVERSITASMEBAN-AREA
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O. MENCETAK LEMBAR KERJA

Langkah-langkah untuk mencetak lembar kerja adalah :
Klik File — Print atau Ctrl - P

Name: Inkjet MP140 series

Status: idle

Type: Canon Inkjet MP140 series

Where: uss001

Comenent: ™ Print
!

@ Al Number of copies:

¢ Page(s) Erom: [ & 10: | -]

Print what: t [ﬁ [ﬁ ¥ cCallate
C Selection " Entire workbook

® Active sheet(s) € Table
r Ignore grint areas

Cancel

Tentukan nama printer dan halaman yang akan dicetak atau tandai
salah satu pilihan pada Print What kemudian klik OK.

UNIVERSITAS MERAN-AREA
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LATIHAN 1.

1. Kerjakan soal berikut dengan menggunakan operator aritmatika dan
fungsi statistik.

2. Buatlah garis pada tabel.

DAFTAR PENJUALAN BAHAN BANGUNAN
PT. ANGGITA LESTARI - MEDAN

NO | BAHAN iy satuan TOTAL o prmava
1 |Semen 100 42000
2 |Batu Bata ' 12000 450
3 |Seng 7 feet 75 43000
4 |Besi9 mili 125 47000
5 |Kayu2x4" 86 75000
Total Penjualan

Penjualan

Penjualan Tertinggi

Penjualan Terendah
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LATIHAN 2.

1. Lengkapi tabel berikut dengan menggunakan fungsi Absolut.
2. Buatlah grafik menggunakan data pemesanan komputer tersebut.

DAFTAR PEMESANAN KOMPUTER
PT. PUSKOM TAHUN 2010

Harga per unit PC =

Rp 3.250.000

NO BULAN JUMLAH %ﬁg
1 Januari 20 unit
2 Februari 35 unit
3 Marct 23 unit
4 April 40 unit
5 Mei 25 unit
6 Juni 20 unit
7 Juli 17 unit
8 Agustus 40 unit
9 Scptember 35 unit
10 Oktober 29 unit
11 ‘Nopcmber 21 unit
12 |Desember 28 unit

JUMLALI

UNIVERSITASMEDAN-AREA
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LATIHAN 3.

1.

Kerjakan latihan berikut dengan menggunakan fungsi logika ff,
operator relasi pembanding dan operator logika.

2. Mengisi Nilai Huruf dengan ketentuan :
a. Nilai rata—rata 85 — 100 A, nilai 75 - 84,9 B+, nilai 65 —
74,9 B, nilai 55-64,9 C+, nilai 45-54,9  C, nilai 35-44,9
D, nilai0-34,9 E
b. Keterangan A (Sangat Baik), B+ (Baik Sekali), B (Baik), C+
(Cukup Baik), C (Cukup), D (Kurang), E (Sangat Kurang).
DAFTAR NILAI MATA KULIAH ILMU KOMPUTER
TAHUN AJARAN 2010/2011
UNIVERSITAS MEDAN AREA
NILAl NILAI NILAI NILA
NO | NAMA TEORI PRAKTEK RATA-RATA HURUF KET.
1 GONZALES 80 75
2 RONALDO 75 85
3 CARLOSPUYOL 65 70
4 OZILMESUT 70 65
5 |CASSILAS 85 70
6 [MESSI 70 90
7 |BENZEMA 80 85
8 MOURINHO 90 85
9 |SO THREESNO 85 90
10 |ADEBAYOR 60 50

UNIVERSITAS MERAN-AREA
54



LATIHAN 4.

1. Kerjakan soal tersebut dengan menggunakan fungsi teks dan fungsi
logika IF.
2. Sortir data tersebut berdasarkan nama atau skor akhir.

HASIL UJIAN PENERIMAAN CALON PEGAWAI NEGERI
KEMENTERIAN INFORMASI DAN KOMUNIKASI

REPUBLIK INDONESIA

O N e T R o
1 RIYAN ERIK SBY001 75 70
2 RENO HADINATA | MDNO002 80 75
3 FADHILLA MKS003 75 80
4 RANO KARENA MDNO004 90 75
5 NORMAN SBY008 90 80
6 JAKABARING SBY006 65 75
7 SALSANABILA BDG007 70 80
8 UDIN SEDUNIA MDNO010 80 90
9 KUMALASARI MKS009 75 85
10 |WARDHANA BDG005 85 80

UNIVERSITAS M EBAN-AREA
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9¢

DAFTAR GAJI KARYAWAN PT. ANDIKA WIRA MANDIRI

NOgs‘

WAN SAKIRA

[

MADA ARHARAP

SAMSON

FAIS AKBAR

ROMANOV

PITER CECH

O ow |~ || e | W

JOKO SISWANTO

10 KAMARUDDIN

w O » U0 W >» 0O w0

MEDAN - SUMATERA UTARA

UNIVERSITAS MEDAN RREA

Tabel Bantu

GAJIPOKOK! 1250000} 1,500.000 i 1,750,000 | 2,000,000

TUNJANGAN 1%; 1.15% 1.25% 1.35%
0.25% 0.50% 0.75% 1%

'dNMOOTH 18ge L

ueeoequiad 1sbung uexeunBbusw uebusp nNyuBq ueylE] UBYIESS|e]

'S NVHILVY



Microsoft PowerPoint
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MICROSOFT
POWER POINT

A. PANEL SLIDE / OUTLINE

slide/outline yang terlihat seperti pada
gambar berguna untuk menampilkan daftar
slide pada presentasi dalam bentuk slide atau
outline. Hal ini untuk memudahkan kita mengelola
semua slide pada presentasi, seperti menampitkan
slide tertentu, memindahkan slide ke depan atau
belakang slide lainnya, atau menghapus slide yang

tidak kita butuhkan.

B. AREA SLIDE DAN OBJEK

Di bagian tengah jendela PowerPoint terlihat area slide seperti
pada Gambar berikut. Bagian ini kita gunakan untuk mendesain slide-
side presentasi yang akan dibuat dengan memasukkan teks yang akan
disampaikan, memformatnya sesuai tampilan yang kita butuhkan dan
memberikan objek-objek slide agar preseasi yang dibuat terlihat jelas,

indah dan menarik.

Slide dalam PowerPoint memiliki tiga bagian utama yaitu Desain

layer, Layout Location, dan Content Object.

1.

Desain layer

Desain layer dapat diberi
background, dikosongkan, ataupun
dikombinasikan dengan teks dan
gambar serta warna.

Layout Location

Layout location ini membantu
untuk menentukan peletakan dari
teks tertentu.
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3. Content Obyek
Content obyek merupakan sebuah objek berupa tulisan, clip art
atau gambar.

C. MEMASUKKAN TEKS KE DALAM PLACEHOLDER

Pada slide yang ditampilkan terlihat
dua placeholder. Karena slide berbentuk
gambar, teks yang ingin ditampikan pada
slide harus dimasukkan ke dalam placeholder Cilck s add itle
ini dengan cara berikut ini:

1. Kilik placeholder dengan teks Click to add
titte pada bagian atas slide untuk
meletakkan kursor di dalamnya.

2. Kemudian ketikkan teks judul presentasi yang ingin dibuat pada
placeholder (contoh: PRAKTIKUM KOMPUTER).

3. KiIik placeholder dengan teks Click to add
subtitle pada bagian bawah slide untuk
meletakkan kursor di dalamnya.

4. Ketikkan teks lain yang ingin ditampilkan
pada slide untuk melengkapi teks judul
presentai yang telah dibuat sebelumnya
(contoh: Kepala Pusat Komputer &
Bahasa)

D. MEMASUKKAN SLIDE BARU KE DALAM PRESENTASI

Setelah membuat slide judul presentasi, kita harus memasukkan
slide baru untuk menampilkkan teks

presentasi. Klik tombol perintah pada
tab Home untuk memasukkan slide baru ke
dalam presentasi seperti terlihat pada
gambar berikut.
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E. MENGHAPUS SLIDE

Jika slide yang kita gunakan pada presentasi tidak ingin
digunakan, maka kita dapat menghapusnya dengan cara sebagai berikut:
1. Klik slide yang akan dihapus pada panel slide/outline.

2. Kemudian klik tab Home, lalu klik tombol perintah delete Delete

pada Group Slides.

F. MENGUBAH LAYOUT SLIDE

Kita dapat mengubah layout slide agar
sesuai kebutuhan dengan bentuk slide yang
akan dibuat dengan cara sebagai berikut:

1. Pada panel slide / outline klik slide yang
akan diubah layout-nya untuk memilihnya
(slide baru).

2. Klik tombol perintah ~ 'B¥O¥E ™ hada tab

Home untuk menampilkan daftar pilihan
layout slide seperti terlihat pada gambar berikut.

3. Kemudian klik pilihan layout yang akan kita gunakan pada slide,
maka layout slide diubah sesuai dengan layout pilihan yang kita
gunakan.

G. MENGETIK TEKS POINT PRESENTASI

Kita telah menambahkan slide baru ke dalam presentasi dan
mengubah layout-nya sesuai dengan bentuk slide yang kita butuhkan.
Untuk mengingat hal-hal yang harus disampaikan dalam presentasi, kita
harus memasukkan teks point presentasi yang harus dijelaskan pada
slide. Cara mengetikkan teks point
presentasi pada slide adalah sebagai

berikut:

1. Klik placeholder dengan teks Click to
add title pada bagian atas slide. e s
Kemudian ketikkan teks judul slide di e

*+ Microsoft PowerPoint

dalamnya (contoh; MATERI).
Ukuran font teks judul slide secara
otomatis akan disesuaikan dengan
ukuran placeholder.
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2.

Klik placeholder dengan teks Click to add text pada bagian bawah
judul slide. Kemudian ketikkan teks point pertama presentasi yang
ingin kita masukkan ke dalam placeholder (contoh: Microsoft Word)
Tekan tombol enter satu kali untuk memindahkan kursor ke baris
berikutnya dan menyiapkan tanda item untuk teks point presentasi
berikutnya. Contoh teks point dapat dilihat pada gambar berikut ini.

H. MENYIMPAN PRESENTASI

Adapun cara menyimpan hasil presentasi yang telah kita buat

sebelumnya adalah sebagai berikut:

il

2.

Klik tombol untuk menampilkan menu Office.
Save As >
Pilih menu untuk menampilkan daftar pilihan format
file presentasi.
PowerPoint Presentation
Save the presentation in the defautt file
Klik pilihan fommaty untuk menampilkan

kotak dialog Save As.

Pada kotak Save /In pilih folder di mana kita akan menyimpan
presentasi yang dibuat.

Pada kotak File nama ketikkan nama file presentasi

Pada kotak Save As Type, pilih file presentasi kembali (PowerPoint
Presentation).

Kemudian klik tombol 2ave pada kotak dialog Save As untuk
menyimpan presentasi di dalam file tersebut.

Setelah proses penyimpanan selesai, pada bar judul jendela
PowerPoint akan terlihat nama file yang kita berikan. Berarti
presentasi telah selesai disimpan di dalam file presentasi tersebut.

Il. MENUTUP PRESENTASI

Setelah menyimpan presentasi dengan member nama file, kita

dapat menutup presentasi tanpa takut kehilangan slide-slide yang telah
kita buat pada presentasi.

il.

Klik tombol
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2.

Klik menu untuk menutup file presentasi yang
telah kita buat.

J. MEMBUKA PRESENTASI YANG TELAH DIBUAT

Mungkin pada presentasi masih ada kesalahan atau kekurangan

sehingga kita ingin membukanya kembali untuk mengedit atau
menambahkan hal-hal yang dibutuhkan pada presentasi.

1.

2.

Q

Klik tombol kemudian klik menu pilihan __L] untuk
menampilkan kotak dialog Open.

Pada kotak Look in pilih folder di mana file presentasi yang akan
dibuka berada.

Kemudian pada bagian Name, klik nama file presentasi yang ingin

diubah.

Klik tombol Open Qpen untuk menutup kotak dialog Open
dan membuka presentasi kembali.

Kemudian lanjutkan pembuatan slide-slide lain yang kita butuhkan
pada presentasi.

K. MEMBUKA PRESENTASI BARU

Jika kita ingin membuat presentasi

lain, kita harus membuka presentasi baru
yang masih kosong dengan cara sebagai
berikut:

Klik tombol Office , kemudian klik

N e
menu pilihan [j untuk

menampilkan kotak dialog New Presentation.

Untuk membuat Presentasi baru dapat memilih menu pilihan

Blank and recent - talfed Theme
atau menu pilihan installed Themes

Perbedaannya yaitu jika menu pilihan [[mmmmmes digunakan

untuk membuat presentasi baru dimana Slide yang akan digunakan
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langsung diberi Design sesuai dengan thema yang kita pilih.

Sedangkan jika menu pilihan Blank andiecen: yang dipilih, maka

slide yang akan kita _ terlihat kosong.
3. Klik tombol create | Cfeate | untuk membuat presentasi baru

L. MENGEDIT TITLE BOXES
1. Menambah, Mengubah, dan Text Formatting

Untuk menambahkan teks dalam

kotak judul, kita hanya tinggal meng-klik i
kotak tersebut. Pada kotak tersebut ada st S

delapan lingkaran kecil untuk mengatur
ukuran besarnya kotak.

Di dalam kotak, kita bisa mengetik, menghapus, mengkopi,
meng-cut, dan mem-paste. Kita juga bisa menambahkan formatting
sepeti bold, italic, mengubah jenis font, warna teks. Jika sudah selesai
melakukan penambahan dan perubahan, arahkan kursor ke luar dari
kotak untuk mengakhiri perubahan yang dilakukan.

2. Memindahkan dan Mengubah Ukuran Title Boxes

1. Memindahkan
Klik teks pada kotak untuk menunjukkan kotak yang
mengelilinginya.
Pindahkan kursor mouse ke ujung-ujung kotak, saat kursor
berubah menjadi bentuk anak panah 4 arah, klik dan geser
kotaknya.

Lepaskan klik mouse untuk meletakkan kotak ke tempat yang
baru.

Ulangi langkah-langkah di atas hingga kotak berada di tempat
yang diinginkan.

2. Mengubah Ukuran Kotak
Klik teks pada kotak untuk menunjukkan kotak
Pindahkan kursor mouse ke bulatan pada tepian kotak hingga
kursor berubah menjadi bentuk anak panah 2 arah
Klik dan geser bulatan tersebut untuk mengubah ukuran kotak
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Dengan mengubah ukuran kotak, maka dampaknya adalah:
(i) Mengklik dan menggeser bulatan atas dan bawah akan

mengubah tinggi kotak

(i) Mengklik dan menggeser bulatan pinggir akan mengubah

lebar kotak

(iii) Menggeser bulatan ujung akan mengubah tinggi dan lebar

kotak

M. MEMBERI NOMOR URUT PADA TEKS

Untuk membuat urutan teks
point presentasi kita dapat

memberikan nomor urut pada teks 1. Windows 7
dengan cara sebagai berikut: 2. Microsoft Word
1. Pilih placeholder di mana teks 3. Microsaft Excel

4. Microssft PowerPoint

yang akan diberi nomor urut

berada.
2. Kemudian klik tombol
Numbering pada tab

MATERI

Home, maka teks-teks point

presentasi pada placeholder diberi nomor urut seperti terlihat pada

gambar.

3. Lakukan langkah-langkah di atas untuk memberi nomor pada teks di

dalam placeholder atau slide yang lain.

N. MEMBERI TANDA BUTIR PADA TEKS

Selain  nomor urut, kita dapat
memberikan tanda butir pada point
presentasi dengan cara sebagai berikut:

1. Pilih placeholder di mana teks yang akan
diberi tanda butir berada.

2. Kemudian klik tombol Bullets " pada
tab Home, maka teks-teks point
presentasi pada placeholder diberi tanda
butir seperti terlihat pada gambar.

MATERI

* Wisdows 7

*« Wicroseft Word

* Microsoft Excel

« Microsolt PowerPoint

3. Lakukan langkah di atas untuk memberi tanda butir pada teks di

dalam placeholder atau slide yang lain.
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O. MEMBERI THEME PADA PRESENTASI

Untuk meberikan kesan menarik, pada slide presentasi dapat
diberikan sebuah theme dengan cara sebagai berikut:
1. Buka file presentasi dimana kita akan memberi theme.
2. Klik tab Design dan tunjuk pilihan theme pada daftar untuk
menampilkan slide presentasi dengan theme yang ditunjuk.
3. Kilik theme yang ingin kita gunakan pada slide presentasi.

P. MEMBERI STYLE LATAR BELAKANG SLIDE

Selain memberikan theme pada slide presentasi, kita juga dapat
memberikan sebuah style latar belakang slide dengan cara sebagai
berikut:

1. Klik tab Design. Pada kelompok Background, klik tombol

untuk menampilkan
kotak daftar pilihan style latar belakang
slide seperti terlihat pada gambar.
Klik pilihan style latar belakang slide yang ingin
kita gunakan pada kotak daftar style latar
belakang slide, maka style latar belakang slide
presentasi diubah sesuai dengan pilihan style
latar belakang yang kita gunakan.

Q. MENJALANKAN PRESENTASI PADA LAYAR MONITOR

Setelah presentasi selesai dibuat, maka presentasi dapat
dijalankan untuk melihat tampilannya pada layar monitor adalah sebagai
berikut:

1. Buka presentasi yang ingin dijalankan atau yang telah selesai
dibuat.

From

2. Klik tab Slide Show, kemudian klik tombol perintah B€giNMNG a4
kelompok Start Slide Show.
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R. MEMBERI! TRANSISI PADA SLIDE PRESENTASI

Transisi merupakan efek perpindahan slide presentasi saat slide

dijalankan. Dengan adanya transisi ini maka slide presentasi akan terlihat

lebih menarik lagi pada saat dijalankan. Adapaun cara untuk membuat

transisi pada slide presentasi yaitu:

1.

Buka file presentasi atau file presentasi yang telah selesai dibuat
dimana kita akan memberikan transisi.

Klik slide yang akan kita beri transisi untuk memilih slide tersebut.
Klik tab Animations. Dan tunjuk transisi yang akan kita gunakan
untuk melihat tampilan

slide yang dipilih.

Klik salah transisi yang

tepat kita gunakan pada slide presentasi.

Lakukan langkah-langkah sebelumnya (2 — 4) untuk memberikan
efek transisi pada slide-slide lainnya. Atau jika ingin

satu transisi saja untuk keseluruhan slide, klik tombol

pada tab Animation.

. MENCETAK SLIDE PRESENTASI

Untuk mencetak slide presentasi dapat dilakukan dengan cara

sebagai berikut:

1.
2.
3.

Klik tombol Print untuk menampilkan kotak dialog Print.

Pada kotak Name pilih jenis printer yang akan digunakan.

Pada bagian Print range pilih slide yang akan dicetak. Klik tombol
untuk mecetak semua slide pada presentasi, klik tombol

pilihan untuk mencetak slide yang ditampilkan, atau

klik tombol untuk mencetak slide-slide tertentu.
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Pada bagian Copies tentukan jumlah salinan slide presentasi yang

dicetak di dalam kotak

Secara default, kita mencetak slide presentasi satu salinan demi

satu salinan secara lengkap. Hal ini ditunjukkan dengan pilihan
yang dipilih. Jika kita ingin mencetak presentasi slide

demi slide dalam jumlah salinan yang ditentukan, klik kotak cek

pilihan ini untuk menghilangkan tanda ceknya.

Pada kotak Print What yang akan

dicetak dan pilih warna slide presentasi pada kotak Color /
grayscale.

Kemudian klik kotak cek toftpaper | ntuk mengepaskan
slide ke kertas, klik kotak cek [JFrame sides |tk memberi frame

pada slide, atau klik kotak cek untuk

mencetak komentar.

Setelah selesai, klik tombol OK.
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Photoshop
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PHOTOSHOP

» ydobe Photoshop adalah sebuah program yang digunakan untuk
perubahan-perubahan (manipulasi) pada gambar, yang
dapat menghasilkkan gambar digital dengan kualitas tinggi. Adobe
Photoshop juga dapat melakukan perubahan-perubahan dari gambar
atau foto basil scanner. Misalnya dengan memperbesar atau
memperkecil gambar yang sudah ada, melakukan rotasi (perputaran),
merubah warna, memberi efek-efek khusus seperti yang terdapat pada
menu filter. Hal yang utama dalam yang akan dibahas pada pengantar
Adobe Photoshop ini adalah :

1. Animasi Teks Berjalan dan Foto / Gambar

Animasi teks berjalan atau biasa disebut dengan running text
adalah sebuah efek yang dapat dialakukan di Adobe Photoshop serta
dapat juga mengolah sebuah Foto/Gambar yang tidak bergerak akan
menjadi bergerak dengan format khusus sehingga dapat menghasilkan
efek-efek unik seperti halnya sebuah film kartun animasi.

2. Manipulasi Foto / Gambar (Ganti Background)

Manipulasi foto adalah salah satu keunggulan aplikasi Adobe
Photoshop, yaitu melakukan perubahan-perubahan pada foto/gambar
baik dari media apa saja yang dapat dengan mudah merubah
foto/gambar baik secara mendasar maupun secara khusus. Dengan
bantuan efek-efek yang ada di aplikasi Adobe Photoshop.

3. Tranparasi Foto / Gambar

Transparasi atau membuat foto/gambar menjadi kelihatan
tampak samar, yaitu metode khusus sebuah efek yang ada dalam
aplikasi Adobe Photoshop dimana memungkinkan sebuah Foto/Gambar
dapat menjadi hilang 90% atau samar-samar. Metode ini sering dilakukan
untuk pembuatn efek poster-poster atau cover-cover film Horor.
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A. MENGAKTIFKAN ADOBE PHOTOSHOP

Caranya :

Untuk mengaktifkan Photoshop, khk Start = All Programs = Adobe
Photoshop CS3.

Cara yang lain juga bisa dengan, klik sortcut Adobe Photoshop CS3 yang
ada di tampilan Desktop.

B. MENGENAL LEMBAR / AREA KERJA

Pada prisnsipnya interface awal Adobe Photoshop hampir sama, yang
membedakannya adalah penambahan-penambahan fiturnya disetiap
versi. Dibawah ini adalah tampilan awal Lembar/ Area kerja Adobe
Photoshop CS3.

Nz o0l

Lembar Kerja / Area Adobe Photoshop CS3

C. MEMULAI KERJA PADA AREA ADOBE PHOTOSHOP

Caranya:

Klik pada menu File  New = (Bila muncul kotak dialok langsung klik:
OK)
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Resolution: 72
RGB Color =
Background Lontents:  Whik
ar Lonten e Imoge See:
3 63,1

Lembar Kerja Baru Adobe Photoshop CS3

1. ANIMASI TEKS BERJALAN DAN FOTO / GAMBAR

Sebelum memulai merancang animasi teks berjalan kita harus
menentukan ukuran clipboard diamana area tempat kerja teks tersebut
digunakan.
Untuk project ini clipboard yang dibutuhkan adalah: 6 cm x 1 cm dengan
resolusi 300 px.
Caranya:
- Bukalah lembar kerja baru.
Kemudian klik icon Crop Tool lalu masukan di Menu Option
Width: 6 cm Height: 1 cm dan Resolution: 300 lalu Enter.
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Dilanjutkan dengan Drag horizontal di lembar kerja lalu Enter.

Hasil lembar kerja clipboard teks berjalan

Lalu klik icon Horizontal Type Tool (T) .
Lalu klik di area lembar kerja teks : SELAMAT DATANG.

Lanjutkan dengan klik Timeline pada bagian bawah, maka akan
muncul window Animation dibawah halaman lembar
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Kemudian klik icon Duplicat selected frame, sehingga akan
muncul du likat frame baru sehin a men'adi 2 frame.

Lalu letakan klik (pilih) frame 1 dilanjutkan dengan menggeser
teks SELAMAT DATANG di lembar kerja ke sudut kiri sehingga
yang muncul hanya 1 huruf terakhir saja. Begitu juga sebaliknya
untuk frame ke 2 digeser ke sudut kanan.

Frame 1 Frame 2

Kemudian letakan dan pilih Frame 1 untuk membuat tambahan
frame lainya dengan cara klik icon Tween animation frame. Jika
muncul window maka rubah Frames to Add menjadi 13 lalu OK.

Iween WRh: Hext Frame  ~

Frames to Add: 13 . Cancel
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- Maka akan bertambah frame menjadi 15 frame, lanjutkan dengan
mencoba untuk menjalankannya dengan cara klik icon Play di
window Animation (Frames) dan lihatlah hasilnya.

Project | : Animasi Teks Berjalan

Buatlah Animasi Teks Berjalan dengan ketentuan efek sebagai berikut:
- Teks berjalan dari KANAN ke KIR! (Arabian Style)
- Lalu di Frame ke 8 Teks berhenti selama 2 (dua) detik lalu berjalan lagi.

2. MANIPULASI FOTO / GAMBAR (Ganti Background)

Langkah awal yang diperlukan dalam Manipulasi Foto / Gambar adalah
menyediakan Foto/Gambar sebagai objek untuk dijadikan project
manipulasi dengan syarat foto/gambar sebagai berikut:

- Sediakan 2 (dua) buah Gambar, Gambar1: Foto Closeup atau Pas
Foto, Gambar2: Foto/Gambar Pemandangan atau lainnya sebagai
pengganti Background.

- Foto / Gambar memiliki Size/Ukuran minimal 500 Kb

- Foto/ Gambar tidak kabur, buram, gelap dan pecah.

- Foto / Gambar mimiliki area khusus sesuai rencana project
manipulasi.

Caranya:
- Buka dan tampilkan 2 (dua) Gambar sebagai bahan manipulasi
project pada lembar kerja Adobe Photoshop.
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Kemudian klik icon Magic Wand Tool (W) lalu klik pada area
background pada Gambar 1, maka secara otomatis background akan
terseleksi. Jika posisi sudah terseleksi langsung tekan tombol DEL
(Delete) pada keyboard sehingga background yang terseleksi
tersebut akan terhapus.

Lalu klik icon Move Tool (V) kemudian letakan posisi kursor
mouse pada Gambar1 yang sudah terhapus backgroundnya
langsung drag dan pindahkan pada Gambar2, sehingga Gambar1
akan bergabung dengan Gambar2.
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Project Il : Manipulasi Foto / Gambar

Buatlah Manipulasi Foto dengan Objek Foto/Gambar anda sendiri di
Negara yang belum pernah Anda Kunjungi.

3. TRANSPARASI FOTO / GAMBAR

Sama halnya dalam manipulasi Foto / Gambar begitu juga dengan
Transparasi Foto / Gambar ada beberapa hal yang perlu diperhatikan
yaitu:

Sediakan 2 (dua) buah Foto, Foto1: Foto Closeup atau Pas Foto,
Foto2: Foto/Gambar Pemandangan atau lainnya sebagai pengganti
Background.

Foto / Gambar memiliki Size/Ukuran minimal 500 Kb

Foto / Gambar tidak kabur, buram, gelap dan pecah. -

Foto / Gambar mimiliki area khusus sesuai rencana project
transparasi.

Caranya:

Buka dan tampilkan 2 (dua) foto sebagai bahan manipulasi project
pada lembar kerja Adobe Photoshop.

Kemudian klik icon Magic Wand Tool (W) lalu klik pada area
background pada Foto1, maka secara otomatis background akan
terseleksi. Jika posisi sudah terseleksi langsung tekan tombol DEL

UNIVERSITAS MEDANAREA—
76



(Delete) pada keyboard sehingga background yang terseleksi
tersebut akan terhapus.

Lalu klik icon Move Tool (V) kemudian letakan posisi kursor
mouse pada Foto1 yang sudan terhapus backgroundnya langsung
drag dan pindahkan pada Foto2, sehingga Foto1 akan bergabung
dengan Foto2.

Untuk membuat efek transparasi, tekanlah angka 1 sampai dengan 9
pada keyboard sehingga tingkatan tarnsparasi pada Foto1 akan
kelihatan.
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SPSS

(Statistical Program for Social Science)
Selamat Belajar......
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SPSS

A. PENDAHULUAN

PSS (Statistical Program for Social Science) merupakan paket

program statistik yang biasanya digunakan untuk mengolah dan
menganalisis data dalam ilmu-ilmu sosial. Untuk melakukan berbagai
analisis data, seperti peramalan (forecasting), melakukan berbagai uji
hipotesis dan masih banyak kegugaan lainnya. Pada buku ini tidak
semua analisis statistik akan dibahas, tetapi hanya sebagian kecil saja.

B. MENGAKTIFKAN SPSS
Start — All Programs — SPSS INC — SPSS

Corel DRAW Graphics Suite 12
Free FLV Player

Games

intel@® Matrix Storage Manager
Maintenance

Microsoft Office

Motorola Driver Installer
Moziila Firefox

QuickTime

Real

ScanSoft OmniPage SE 4
SPSS Inc

Startup

TransToot

Winamp

Winamp Detector Plug-in
WinRAR

WinZip

Sehingga tampil SPSS Data Editor berikut :
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Eile Edit View Data TIranstorm Anatgze Graphs Utiliies Ado-gns Window Heip

Tampilan utama menu SPSS terdiri dari :

1.

File : untuk membuat file baru (New), membuka file (Open),
menyimpan file (Save), Print dan lain-lain.

Edit : untuk memoaodifikasi/mengubah/mencopy data dengan sub
menu antara lain : Undo, Cut (Ctrl X), Copy (Ctrl C), Paste (Ctrl V),
Select, Clear (Del), dan lain-lain.

View : mengatur tampilan SPSS seperti status bar, gridlines, dan
lain-lain.

Data : digunakan untuk memilih dari file data SPSS, seperti
menyisipkan variabel, transpose, merge file, memili case, dan lain-
lain.

Transform : digunakan untuk memodifikasi nila’ ariabel baru
dari variabel yang sudah ada dengan ope as

artimatika atau membentuk variabel nilai-nilainya
merupakan hasil transformasi dari variabel ya ada.

Analyze : digunakan untuk memilih e statistik, yaitu
deskripsi statistik, perbandingan mea lasifikasi, non

parametrik dan lain-lain.
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10.

Graphs : digunakan untuk menampilkan grafik, misalnya : bar,
histogram, pie, diagram pencar, grafik normal, dan lain-lain.

Utilities : digunakan untuk menampilkan variabel-variabel yang ada
pada file, menampilkan berbagai informasi mengenai isi file dan lain-
lain.

Window : digunakan untuk mengatur, memilih atribut-atribut yang ada
di SPSS, menampilkan layar-layar yang digunakan oleh SPSS.

Help : digunakan untuk membuka window Help yang memuat
informasi bantuan bagaimana menggunakan berbagai fasilitas pada
SPSS.

C. MEMBUAT DATA BARU

Setelah window data editor terbuka, kita dapat membuat file baru,
adapun tampilan data editor seperti bentuk spreadsheet Micorosft Excel.
Adapun cara membuat data baru adalah sebagai berikut :

Klik menu bar Variabel View sehingga tampil kotak dialog SPSS
Data Editor.

Neme Type Width  Decimals Label Values

Ketik nama variabel isikan tipe data sesuai yang diinginkan, yaitu :
Numeric : data yang berbentuk numerik, dianggap valid dalam
bentuk angka, bisa bertanda plus maupun minus di depan angka.

UNIVERSITASMEDANT%EA_



Comma : data ini berbentuk numerik, dianggap valid bila dalam
bentuk angka, bisa bertanda plus maupun minus di depan angka,
ditandai koma sebagai pembeda ribuan.

Dot : data ini berbentuk numerik, dianggap valid bila dalam
bentuk angka, bisa bertanda plus maupun minus di depan angka,
ditandai titik sebagai pembeda ribuan.

Scientific Notation : data ini berbentuk numerik, dianggap valid
bila dalam bentuk angka, bisa bertanda plus maupun minus,
ditandai dengan simbol E.

Date : tipe data ini dalam bentuk format waktu.

Dollar : data ini berbentuk numerik, dianggap valid bila dalam
bentuk angka, yang ditandai ($) dengan tanda koma sebagai
pemisah tanda ribuan.

Custom Currency : bentuk tipe ini digunakan untuk menampilkan
format mata uang yang dibuat melalui kotak dialog Options dari
menu Edit.

String : data ini dalam bentuk huruf/alphaetic, angka dan karakter
lainnya.

Width dan Decimal : secara otomatis akan berisi sesuai dengan pada
saat diisi tipe variabel.

Label : ketikkan nama sesuai dengan identitas dari nama variabel,
karena nama variabel hanya terdiri dari 8 digit/karakter. Bila lebih
maka yang ditulis hanya 8 karakter saja.

Values : digunakan untuk mendefenisikan variabel dengan data
berbentuk kategori.
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@ Value Labels

Spelling.

1.00 = "Laki-Laki"
2.00 = "Perempuan”

OK Cancel Help

- Missing : untuk menentukan nilai-nilai missing. Prosedur SPSS

Missing
INone

adalah klik pada kolom Missing pada tombol maka akan

ditampilkan kotak dialog Missing Values.

@ Missing Values

missing

Discrete missing values

Range plus one optional discrete missing value

Cancel Help
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No missing values : tidak ada nilai missing.
Discrete missing values : bila pada variabel tersebut
mengandung 1, 2 atau 3 nilai/macam missing.
Range plus one optional discrete missing value : mendefenisikan
nilai missing pada suatu bilangan interval dan bila tidak cukup
masih ditambah satu nilai.
Measurement : merupakan skala pengukuran yaitu nominal, ordinal,
dan scale.

D. PERINTAH COMPUTE

Perintah digunakan apabila kita ingin mendapatkan variabel baru dengan
melakukan transformasi dengan menggunakan fungsi aritmatika, fungsi
statistik maupun fungsi distribusi.

1. Prosedur Compute

Untuk melakukan prosedur ini, langkah-langkahnya adalah sebagai
berikut :
1. Transform — Compute Variable

Visible; D of O Variables

2. Dalam kotak dialog tersebut terdapat kotak isian :
Target Variable : merupakan nama variabel baru dengan tipe
dan label yang diinginkan.
Numeric Expression : merupakan tempat untuk melakukan
transformasi yang kita inginkan, dengan menggunakan aritmatik
dan fungsi numerik atau fungsi statistik.
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2. Operator dan Fungsi pada Compute
Operator Aritmatik

Penambahan, pengurangan, perkalian, pembagian, eksponensial.
Fungsi Statistik

Sum, mean, standar deviasi, varian, minimum dan maksimum.

E. STATISTIK DESKRIPTIF

Statistik Deskriptif lebih berhubungan dengan pengumpulan dan
peringkasan data, serta penyajian hasil peringkasan tersebut. Data-data
statistik yang bisa diperoleh dari hasil sensus, survey atau pengamatan
lainnya umumnya masih acak, mentah dan tidak terorganisir dengan baik
(raw data). Data-data tersebut harus diringkas dengan baik dan teratur,
baik dalam bentuk tabel atau presentasi grafis.

1. Frequencies

Frequencies membahas beberapa penjabaran ukuran statistik deskriptif
seperti mean, median, kuartil, persentil, standard deviasi dan lainnya.

2. Descriptives

Descriptives berfungsi untuk mengetahui skor z dari suatu distribusi data
dan menguji apakah data berdistribusi normal atau tidak.
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Contoh :

*Latihan Excel sav [DataSet1]} - SPSS D

Elle Edit View Data Transform Analyze Graphs Utiities Add-gns Window Help
2 & &0 8EF & Hd

Pendidikan Masa__Ker] Gay_Pokok var

Freddy Pria SLTP 3 700,000

2 Ina Wanita Akaderni 900,000
Wanita Sarjana 2 1,250,000

4 Pria SLTP 5 700,000
5 Pria Master/MBA 6 1,750,000
Wanita Sarjana 3 1,400,000

Xena Wanita Sarjana 2 1,250,000

Johny Pria SMU &) 1,000,000

9 Cecilia Wanita SMU 2 950,000
10 Pria Master/MBA 4 1,500,000
" iSusy Wanita Sarjana 2 1,250,000
12 Wanita SMU 3 1,000,000
13 Imendy Pria SLTP 750,000
Pria Akademi 900.000

Jenny Wanita Akademi 2 850,000

Langkah-langkah menentukan Mean, Median, Standard Deviasi dan lain-
lain.
1. Analyze - Descriptive Statistics — Frequencies

Sehingga tampil gambar berikut :

Yariable(s): Statistics...
& Masa_ Kerja =
Pendidikan Charts...
& Gaji_Pokok Format
[V] Display frequency tables
Paste Reset Cancel Help
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2. Pada tombol Statistics dan chart, tentukan fungsi-fungsi statistik dan
grafik yang diinginkan.
3. Kemudian klik OK.

Output yang dihasilkan adalah :

Frequencies
Statistics

‘ Masa__Kerja Pendidikan  Gaji_Pokok
N valid fome o 15 15 15

Missing T o o 0
Mean o 327 ' 1,076,666.67
Median i 0 3000  1,000,000.00
Mode o 2 [ 1,250,000
Std. Deviaton C 12800 | 311,601.088
Minimum 2. . 700000
Maximum — 6 L 1,750,000
a. Multiple modes exist. The smallest valueis shown

Masa__Kerja
. . , , ., Cumulative
' Frequency, Percent ;Valid Percent; Percent
vald 2 5 333 333 333

3 5 333 338 66.7,

4 20 1331 133 80.0

N 2. 18k 133 933

6 1 ern 67 100.0

Total | - 15, 1000, 1000;
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Pendidikan

: . . . . Cumulative
I R .Frequency . Percent |Valid Percent. = Percent
Valid -Akadem| ) 3 200! 200! 20.0
""""""" | . e I
jX'aSte”MB | 2 133 133! 33.3
e e FH T A 267 T 60.0
l'"“ """" S — SESASASASISAS [P e e T
:SL'( P ! 3; 20.0; 20.0: 80.0
[T - P [ SRR it - i = Fe=- """~
SMU_ 3,200 2000 1000
Total | 15/ 100.0! 100.0!
Gaji_Pokok
! ' ' x ' Cumulative
| — ' Frequency | Percent | Valid Percent |  Percent
Valid ;700000 ¢ 2 133 138 139
'799999__? __________ Toern 671 200
850000+ 1ver 67, 267
900000 | 2 133 133 . 400
950000 | 1 ern 67, 46.7
1000000 2 133 133 60.0
1250000, 3 200 200, 80.0
1400000 T ern 67 86.7
15000000 87T 67 933
1750000 - e 67, 1000
Total ! 15, 1000' 100.0¢
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Bar Chart
Masa__Kerja
.
23
®
3
o
E
e
Masa__Kerja
Pendidikan
Akadent Sarjary
Pendidikan
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Gaji_Pokok

>2
E
N
u.
700000 7S0.000 S5w,000 ©00,000 950.000 1000000 1250000 1400000 1500000 1750000
Gaji_Pokok
Descriptive Statistics

’ i ' i | Std.

‘ N " Minimum ! Maximum ' Mean ' Deviation
""""""" . | - R 1S { IER S —
Masa__Kerja 15: 2. 6: 3.27 1.280
""""""" e | [ I
Gaji_Pokok + 1,076,666 311,601.08

15, 700,000: 1,750,000 :

, : : 67 8
""""""" B ) T e ) T e .
Valid N
s 15!

(listwise)
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F. UJI VALIDITAS DAN RELIABILITAS

Variabel-variabel yang ingin diungkap dalam riset manajemen
pada umumnya kualitatif, contoh: motivasi, kinerja, profesionalisme dan
sebagainya. Variabel ini digali dengan menggunakan questionare yang
kemudian dianalisis secara kualitatif. Untuk itu item-item pertanyaan
dalam questionare perlu diuji apakah benar-benar merupakan ukuran
yang tepat.

1. Uji Validitas

Uji validitas adalah uji tentang kemampuan suatu questionare
sehingga benar-benar dapat mengukur apa yang ingin diukur. Cara
meguiji validitas item-item pertanyaan adalah dengan membuat korelasi
skore pada item itu (yang diuji) dengan skor total.

Misalnya motivasi diungkap dengan 10 pertanyaan. Apakah
jawaban pertanyaan nomor 3 konsisten dengan total skor yang dipilih
oleh seluruh responden?

Jika r (korelasi), dengan (df = n-k, dimana: n = besar sampel, k =
konstruk = variabel) maka item tersebut valid. Besarnya r tiap butir
pertanyaan dapat dilihat dari SPSS pada kolom Corrected Items Total
Correlation. Kriteria uji validitas secara singkat (rule of tumb) adalah 0,3.
Jika korelasi sudah lebih besar dari 0,3 pertanyaan yang dibuat
dikategorikan shahih / valid. Atau jika Sig (2 tiled) > 0,05 maka tidak
valid, tetapi jika Sig (2 tiled) < 0,05 maka pertanyaan yang dibuat
dikategorikan shahih/valid.

Langkah-langkah Uji Validitas :
1. Masukkan data pada Data View.
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Q1 Q2 Q3 Q5 Q6 Q7 Q8 Q9 Q10  Total

1 300 200 3.00 3.00 1.00 3.00 2.00 2.00 200 200 23.00
2 400 3.00 4.00 2.00 3.00 4.00 3.00 3.00 3.00 3.00 32.00
3 200 200 2.00 1.00 2.00 200 2.00 2.00 2.00 200 19 00
4 1.00 1.00 1.00 400 400 1.00 1.00 1.00 200 200 18.00
S 1.00 2.00 2.00 2.00 3.00 1.00 1.00 1.00 1.00 1.00 15 00
2,00 200 2.00 3.00 2.00 2.00 2.00 2.00 2.00 2.00 2100
200 3.00 3.00 1.00 2.00 2.00 2.00 200 200 200 2100
8 3.00 4.00 3.00 4.00 3.00 2.00 2.00 3.00 300 3.00 3000
9 3.00 300 400 3.00 400 2.00 2.00 3.00 2,00 3.00 29.00
10 400 3.00 3.00 2.00 2.00 3.00 4.00 4.00 400 4.00 34.00
" 3.00 2.00 2.00 3.00 1.00 1.00 2.00 2.00 3.00 200 21.00
12 200 3.00 3.00 1.00 2.00 2.00 3.00 3.00 2.00 200 23.00
13 2.00 4.00 4.00 2.00 3.00 300 3.00 4.00 200 200 30.00
14 300 400 4.00 3.00 3.00 3.00 3.00 4.00 1.00 3.00 3100
15 3.00 200 2.00 1.00 1.00 1.00 1.00 2.00 300 200 18.00
18 200 400 4.00 4.00 3.00 3.00 4.00 4.00 3.00 400 35.00
400 400 400 3.00 3.00 300 4.00 4.00 2,00 200 33.00
400 200 2.00 2.00 1.00 2.00 2.00 2.00 2.00 200 2100
100 200 2.00 400 1.00 2.00 2.00 2.00 2.00 23.00 21.00
100 3.00 2.00 1.00 2.00 3.00 3.00 3.00 200 3.00 23.00
21

2. Kemudian Analyze — Correlate — Bivariate...
3. Masukkan seluruh variabel ke dalam kotak Variables termasuk Total
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4. Klik OK
5. Output yang dihasilkan

Correlations

Q1 |az2|a3|as|as|as|ar|as|as|aioftota

Q1 Pearson .

s 1| .302|.4747|-.023|-.025| .383| 373| .431| 454 | 197|536

Sig. (2-

! .195| .035| .924| .916| .096| .106| 058 .044| .404| 015

tailed)

N 20| 20| 20[ 20| 20| 20| 20| 20| 20| 20| 20
@ Pearson o FTest| ol o fe20|.738| 8021 | :570 [.830

Correlation

Sig. (2-

: 195 .000| .783| .085| .003| .000| .000| 672 .009| .000

tailed)

N 20| 20| 20[ 20| 20| 20| 20| 20| 20| 20| 20
Qs Pearson o Lest| [ T T7is | esz[et7| L 8o

Correlation

Sigs (22 035/ .000 704| .069| .000| .001| .000]| .746| 022 .000

tailed)

N 20| 20| 20 20| 20| 20| 20| 20| 20| 20| 20
Q4 Pearson

oo o ~023[ .066| .001| 1| .284|-.014| .020| .056| .050| .283| 294

Sig. (2- 924 783 704 226| .953| .932| .815| .834| 226 208

tailed)

N 20| 20| 20[ 20| 20| 20| 20| 20| 20| 20| 20
Q5 Pearson _gycl 395( .414| .284| 1| .203| 238 .348|-056| 315|481

Correlation

Sig. (2- 916/ .08s| 069 226 389| .312| .133| .815| .176| 032

tailed) 2154 086] O . -389] .312} 133/ .815] .176] .

N 20| 20| 20] 20| 20| 20| 20| 20| 20| 20| 20
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Q6 Pearson .629°|.715 .790 |.736 .610.768

coarson | 383 |-014| 203| 1 151

Sig. (2-

: .096| .003| .000| .953| 389 .000| .000| .525| .004| .000

tailed)

N 20| 20| 20| 20| 20| 20[ 20| 20| 20| 20| 20
Q7 Pearson .7381.682 790 895 662 |.843

coarson | 373 020| 238 1 313

Sig. (2- 106| .000| .001| .932| 312 .000 ooo| .180| .001| .000

N 106| .000| .001| .932] 312 . .000| .180| .001] .

N 20| 20| 20| 20| 20| 20| 20| 20| 20| 20| 20
Q8 Pearson |, ee2 87| I [736]895| | ,.o[735] 01

Correlation

Sig. (2- .058| .000| .000| 815 .133| .000| .000 234| .000| .000

tailed)

N 20| 20| 20| 20| 20| 20| 20| 20| 20| 20| 20
Q9 Pearson | 541 401| 077] 050|-056| 151| 313| 279| 1 531] 399

Correlation

Sig. (2- .044| 672| .746| .834| 815| 525| 180| 234 016/ .081

tailed)

N 20 20| 20| 20| 20| 20| 20| 20| 20| 20| 20
Q10 Pearson [ o -fs70] (oo f o1 Te10] 662 735] . [ |78

Correlation

Sig. (2- .404| .009| .022| 226 .176| .004| .001| .000| .016 000

tailed)

N 20| 20| 20| 20| 20| 20| 20| 20| 20| 20| 20
Total Pearson | o[ .830] 849 o " T 7687 8az019] o[ 786] |

Correlation

Sig. (2-

; .015| .000{ .000| .208| .032| .000| .000{ .000| .081| .000

tailed)

N 20 20| 20| 20| 20| 20| 20| 20| 20| 20| 20

*. Correlation is significant at the 0.05 level (2-tailed).
** Correlation is significant at the 0.01 level (2-tailed).

2. Uji Reliabilitas

Suatu questionare disebut reliabel/handal jika jawaban-jawaban
seseorang konsisten.

Reliabilitas dapat diukur dengan jalan mengulang pertanyaan
yang mirip pada nomor-nomor berikutnya, atau dengan jalan melihat
konsistensinya (diukur dengan korelasi) dengan pertanyaan lain.

Jika Cronbach Alpha > 0,6 maka reliabilitas pertanyaan untuk mengukur
kualitas pelayanan tersebut tinggi/bisa diterima.
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Langkah uji Reliabilitas
1. Masukkan data pada Data View.
2. Kilik Analyze — Scale — Reliability Analysis

3. Masukkan seluruh variable kecuali Total ke dalam kotak Items dan
pilih pada box model Alpha
4. Kilik Statistics dan pilih scale if item deleted lalu pilih Continue

(JE test
() Friedman chi-sguare

Cochran thi-square

[IHotetling's T-square [ Tukey's test of addtivity
[Jintraciass cerrelation coefficient
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5. Lalu klik OK

Case Processing Summary

N

%

Cases  Valid 20 100.0

Excluded? 0 .0

Total 20 100.0
a. Listwise deletion based on all variables in the procedure.

Reliability Statistics
Cronbach's
Alpha N of ltems
.857 10
Item-Total Statistics
Cronbach's

Scale Mean if [Scale Variance if| Corrected ltem-  Alpha if item

Item Deleted Iltem Deleted | Total Correlation Deleted
Q1 22.4000 32.147 397 .859
Q2 22.1500 29.503 174 .825
Q3 22.1000 28.937 796 .822
Q4 22.4500 35.208 121 .886
Q5 22.5500 33.103 344 .863
Q6 22.6500 30.661 701 .832
Q7 22.5000 29.105 .788 .823
Q8 22.2500 27.776 .887 812
Q9 22.6500 34.976 .295 .862
Q10 22.4000 31.200 731 .832
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Microsoft Visio

Selamat Bgé@ﬁm ......
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Microsoft Visio

Microsoft Visio adalah aplikasi untuk menggambarkan diagram
yang dapat membantu kita untuk memvisualisasikan informasi yang
kompleks. Untuk membuat berbagai jenis diagram, mulai dari diagram
jaringan sampai ke kelender dan mulai dari tampilan teks biasa sampai
ke bentuk flowchart.

Ketika kita membuat aplikasi Visio, maka tampilan program sebagai
berikut:

Layar program dibagi menjadi 3 bagian, bagian kiri merupakan sistem
navigasi yang menggantikan menu File. Section Tempate berada pada
bagian tengah, dan pada bagian kanan merupakan bagian preview untuk
template yang sudah disediakan.

A. Memilih Template

- Bagian Recently Used Template menampilkan template yang
barusan digunakan.

- Bagian Template Categories menampilkan kategori template,
mengklik salah satu kategori akan menampilkan semua template yang
berhubungan dengan kategori tersebut. Dengan melakukan double-
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click pada template untuk membukanya atau pilih template dan klik
tombol ' create

Jika kita memilih kelompok yang salah, klik ikon Home untuk kembali
lagi ke sebelumnya, dan pilih template yang sesuai dengan keinginan.

Cheose a Template

& Home

B. Membuka Contoh File

Sebelum kita menjelajah diagram Visio lebih lanjut, marilah kita lihat dulu
contoh file Visio. Dari bagian Home, pilih Others Ways to Get Started,
dan pilih Sample diagrams.

Other Ways to Get Started

Blank Office.com Sample New from
drawing templates diagrams existing

Maka tampilan dari Visio dapat kita lihat seperti pada Gambar berikut:

Pilih Process Improvement, kemudian pilih Metric Units atau US Unit.
Kemudian klik tombol Open. Sehingga tampil gambar seperti berikut:
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C. Tampilan Layar Visio 2010

Menutup, menyimpan dan membuka Diagram pada Microsoft Visio
adalah sama dengan aplikasi-aplikasi yang lain.
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D. Bekerja dengan Drawings

Mari kita membuka basic flowchart dan kemudian belajar bagaimana
menambahkan shape/bentuk baru. Pilih Create.

Untuk menempatkan gambar shape ke Drawing Area, kita dapat memilih
gambar yang kita inginkan dan drag (geser) ke area gambar. Begitu
seterusnya untuk menempatkan dan membuat gambar-gambar yang lain.

Drawingt < Miccaseft Visio

Sebagai contoh, kita bisa membuat bentuk gambar berikut dengan
menggunakan fitur auto-connect yang sudah disediakan pada Shape
Pane. Sedangkan untuk membuat garis penghubung kita dapat
menggunakan fasilitas Ribbon Design — Connectors.

Menambah teks pada Shape, kita dapat melakukan klik 1x pada shape
yang ingin kita beri keterangan, kemudian langsung mengetik dengan
keyboard. Selain itu, kita juga bisa melakukannya dengan meng-klik 2x
shape, kemudian dengan mengetikkan keterangan.
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E. Menghubungkan Shape secara Manual

Contoh berikut adalah bagaimana menghubungkan Shape simbol
pencabangan pada suatu proses. Kita akan manambahkan dua buah
garis untuk menjelaskan 2 kemungkinan pencabangan yang terjadi, yaitu
jika Ya atau Tidak.

Langkah-langkahnya adalah sebagai berikut:
Pilih Shape bentuk Diamond

- Pilih tombol Connector dari tab Home.

- Gerakkan mouse ke posisi seperti pada Gambar di bawah ini,
kemudian tarik dan hubungkan dengan bentuk Shape yang lain.
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F. Tipe Connector

- Koneksi Statis (Koneksi Point)
Untuk menjaga konektor terpaku pada titik tertentu pada
shape/bentuk, tarik dari titik koneksi pada bentuk pertama ke titik
koneksi pada bentuk kedua. Titik akhir konektor berubah menjadi
merah ketika shape/bentuk terhubung.

Studi Literatur Studi Literatur
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Koneksi Dinamis (Shape/Bentuk ke Shape/Bentuk)

Untuk memungkinkan konektor bergerak bentuk ketika bentuk
dipindahkan, posisi alat Konektor atas pusat dari bentuk pertama
sampai kotak merah muncul di sekitar bentuk. Tahan tombol mouse
dan tarik ke pusat bentuk kedua. Ketika kota merah muncul di sekitar
kedua membentuk, lepaskan tombol mouse.

Studi Literatur Studi Literatur

G. Memberikan Teks pada Connector

Langkah-langkahnya sebagai berikut:
Lakukan double klik pada konektor dimana kita akan memberikan
tulisan, atau klik sekali pada konektor lalu pilih Tools Text pada
Home.

Ketikkan tulisan yang akan kita tambahkan pada konektor, seperti
terlihat pada gambar berikut:
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H. Menambahkan Border, Title dan Background

Kita dapat mengakses background dari tab desain, untuk menambahkan
gaya ini ke diagram kita. Dari drop down klik pada background yang kita
ingin terapkan.

Untuk memilih background tersebut, klik Ribbon Design, pilih
Background.

Klik tombol Drop

Down
Background
D Bseman T ¥erve
[svanma  £F o
(Tlcmmms  cotame

oﬂﬂmc {Jonmage
dowes  \J wimerce

Setelah kita memilih salah satu background, maka terbentuk sebuah
halaman baru yang disebut VBackground-1, seperti gambar berikut:
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Jika kita tidak menyukai latar belakang tersebut, kita dapat mengulangi
proses di atas baik memilih background baru atau tidak.

|. Borders dan Title Stencils

Design, klik
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J. Mengedit Title/Judul

Untuk mengedit title, klik VBackground-1 dan pilih objek atau
judul yang ingin diganti teksnya dan overtype dengan teks yang kita
inginkan. Kemudian kembali ke halaman gambar Page-1.

K. Mengatur Stencils

- My Stencil

Suatu stencil (.vss file) adalah kumpulan koleksi shape dan
masing-masing koleksi tersedia pada template Visio (.vst files). Untuk
lebih mudahnya, kita dapat meng-copy sebuah shape dalam sebuah
stencil khusus untuk stensil favorit kita.

Custom Stencil disimpan dalam folder My Shapes, di My
Documents.

- Membuat Stencil Baru
Pilih More Shapes — New Stencil (Metric)
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@) Brawingl

Shapes
More Shapes
Basic Flowchart Shapes (US units) Find Shapes Oniine..,
Cross-Functional Fiowchart Shapes (US ... My Shapes
Stencifl o =
) Bysiness

Favorites

Engineering
ZTI] Flowchart
Drop Quick Shapes heer

General

Raps and Floor Plans
Hetwork
Sehedule
Software and Database »
Wisio Extras

@; Dpen Stencit...

@ New
MNew Stenail (Ug Units}
Show Rocument Stencil

Sehingga tampil stencil baru di jendela stencil pane, yaitu Stencil1

Stenciti
Bysiness »
Favorites
Epgineering
fwont§ Flowchait
Drop Quick Shopes here
General

- Menutup Stencil

Untuk menutup stencil, klik kanan pada nama stencil dan pada
menu, pilih close.

- Membuka Stencil

Pilih more shapes, my shapes kemudian pilih stencil yang kita
buat.
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@_.] Drawingl

Shapes

More Shapes

Quick Shapes Eind Shapes Oniine...

Basic Flowchart Shapes (US units) Favorites
Business Stentill
Engineering Qrganize My Shapes

. Flawchart

Drop Quick Shapes here

aeneral

HMaws and Fisor Mans
Metwork

Schedule

Sottware and Database *

Visio Exdras

fg Open Stencil...
New Stencil Metric}
New Stendl (US Units}

Show Document Stenil

- Float Stencil
Drag dari nama stencil ke dalam ‘endela gambar utama.

rocess

C Start/End

- Re Dock Stencil

Untuk melakukan ~dock— stencil lagi, drag stencil kembali ke
panel stencil.

- Menambahkan shape/bentuk ke Stencil
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Untuk menambahkan shape pada Stencil yang kita buat, dengan
cara:

Buka stencil kita kemudian drag ke layar gambar.
Cari bentuk yang kita inginkan dan tarik ke stencil kita.

Kemudian kita akan melihat pesan seperti gambar berikut, klik Yes
untuk melanjutkan.

Microsoft Visio

This stend s open read-only. Would you ke to edit the stend, so that the operaton can be completed?

- Mengakses kumpulan stencil lain

Ketika stencil membuka template yang sesuai dengan apa yang
kita pilih, kita dapat membuka setiap stencil set ke Visio atau setiap file
berekstensi .vss.
Pilih dan klik More Shapes, kemudian pilih shape yang kita inginkan
(misal: Engineering — Mechanical Engineering — Fasteners 1)

Sestch for Shapes

Find Shapes Onkine.o

Buniness
Engineenng
Lomputers andl Flowehant Yechankal Engintering » 1 Fasteners 1 Metrig
@ ac @ i::;;z . General Precess Eogineeing ¥ G Foseners 1{US untly)
{ #apsand Flear Piens B Fastenens 2 Metiig
Network Bl Fasteners 20US unitsy
Schedute & Sosid Fomer - Equipment Fting
3 :;::m " PDA Software and Database » T Fisid Pewer . Equipment {US units)
Visis Extras B Frusd Pavee - Valve Asssmobly Metrig
L %t'z’ R & openstenal.. U Fiuis Powar . Valve fssambly IUS unis)
@ i s«@ few Stency Bctrict B Fuss Pewer . Valves Mexic
B Hew Stendi US Units B Pt Power - Vaives (US unit)
Show Documeat stenct & Seomstric Dimensioning and Toitransing (Metricj
B Gromelns Dimensioning and Toteransng (S unitsh
~A B8 spegs and Beatings a2

Swrinas and Bearings U5 units)
Wekding Symbols Metric)
iziding Symbots S units}

&

Untuk menambahkan shape yang kita inginkan pada bagian ini, drag
shape lalu masukan ke Stencil kita.
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L. Kategori Template

Selain menggambar basic flowchart, kita dapat membuat gambar
lain sesuai dengan kebutuhan bidang ilmu kita. Cara membuat gambar
dengan template yang lain adalah sama dengan membuat gambar pada
basic flowchart.

Kategori template yang tersedia pada Microsoft Visio antara lain:

1. Bidang Bisnis (Business)

Shcose a Template Audit Disgram

PeacesEEs.

UM Ciagam  Mwketing Chats = et Son Chan tagr S Sigme Dtagrarm
2na Diagams Viisaed

2. Bidang Rekayasa (Engineering)

Indugtna Control  Part and Aszemibly #iping snd
Systems Drasting Indeumentation
Dazgam
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3. Jaringan (Network)

Choose a Template Active Divectory

* + @ Home » Network

4. Diagram Software and Database

Choose » Tamplate COM and OLE

[ Date Flow & Enterprise
Site Diagram Oiagram Agphcaton

5. Schedule

Choose a Tempiate
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6. Ma s and Floor Plans

7.

e Loyt Plupdiogand  ReflectedCeiling  Sacurty sadAccess
FigingPlan Pan Blan

Diagram Alur Kerja (Work Flow Diagram)

Choosa a Template

2 D Home

Dgram (Metric) uaiy) {Mlatiin

Guminers  Engieesing
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Work flow Disgram (Makich

Lot Giamems of ntreana
TE0s, IR PIOE
management, ind human




Tugas 1. Disain Gambar Jaringan
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Tugas 2. Flow Chart

Ya

= Tidak  Ada CD? > Tidak
Ya Ya
v
Ada 0S?
Ya Ya l
e S S o
Bawa OS ke Bawa OS ke
Memori ’
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Tugas 3. Disain Gambar Dua Dimensi
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